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one of the following:

ph or drawing

ut you want a black-and-white image to 
reen

 size. See "How can I reduce the file 

nd white by selecting the Black & White 
ressing the Copy button ( ). Or, in 
are, choose the Grayscale or Black & 

r final scan (after the scanner completes 
g output type" on page 43.
oftware, select the Extend lamp time 
. When selected, this setting keeps the 
t source (if connected) on beyond the 
etting preferences" on page 68.
Getting started

quently asked questions

ction contains answers to some questions users frequently ask 
scanning.

settings does the HP Precisionscan Pro software set 
atically for an item I scan?
 on the scanned item, the software automatically chooses 
l values for these settings:

tput type

olution

arpening

posure (midtones, highlights, and shadows)

lor (hue and saturation or black & white threshold)

y, the values the software selects provide optimal results. 
er, you can change these values in the HP Precisionscan Pro 
re.

How can I reduce the time it t
You can reduce the time it take
and white when the original is 

� a black-and-white photogra

� a color photo or drawing, b
appear on the computer sc

� contains only text

Another option is to reduce file
size?" on page 21.
Print color originals as black a
option on the front panel and p
the HP Precisionscan Pro softw
White output types before you
a preview scan). See "Selectin
In the HP Precisionscan Pro s
out setting on the Scanner tab
scanner lamp and the XPA ligh
default time out period. See "S
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n zooming and resizing?
of the scanned image close up. Use 
inal view of the image. 
hange the final size of your scan; they 
n a monitor. To reduce or enlarge the 
esize command on the Tools menu.

t scanning text?
ning text, you can use the text either as 
x or image archive, or as text you can 

ecognition (OCR) software make the 
 send the text to a supported word-
 Scan To button ( ). In the HP 
se the output type of Editable Text 
, on the Scan menu, click Scan To, 
program, and click Scan.

ck after you have successfully 
o a word-processing program.
to TOC

n I reduce the file size?
e file size:

 files using a compressed format, such as TIFF compressed 
EG.

d using the True Color output type unless necessary. This 
ut type offers exceptional quality for color photos or drawings, 
t also creates large file sizes.

the resolution no higher than necessary. Generally, the 
lution the software automatically sets provides the best 
nce between image quality and small file size.

photos, significantly reduce file size by cropping the photo to 
ct just one area as the final scanned image. Or, resize the 
e photo to smaller dimensions.

I change the resolution?
Precisionscan Pro software sets the resolution for you based 
riginal document attributes. In almost all cases, you get the 
ults and the smallest file size using the default resolution.

 the difference between screen and print quality?
ter screen usually displays images at 72 to 75 pixels per inch 

rint resolution is usually higher. Screens also use fewer colors 
y an image. Even if an image looks incorrect on the screen, it 
int the way you want.

What is the difference betwee
Use Zoom In to view an area 
Zoom Out to return to the orig
The zoom commands do not c
just give you a different view o
size of the final scan, use the R

What do I need to know abou
When you scan an item contai
a scanned image, such as a fa
edit.
To have the optical character r
text editable automatically and
processing program, press the
Precisionscan Pro software, u
(OCR) or Text & Image. Then
choose your word-processing 

   

Tip Perform a spell-che
scanned your text t
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page 39

Tip
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Scanning from scanner buttons 

nner buttons provide an easy way to scan items directly to 
ions using settings optimized for the destination you choose. 
ot view or change scanned images before they go to the 

ion.
or change images, scan to the HP Precisionscan Pro software 
e Scan To button ( ). For more help viewing or changing 
 see "Overview of the HP Precisionscan Pro software" on 
.

You can change the default settings for some 
buttons on the scanner. See "Changing settings for 
buttons" on page 34.
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are-to-Web wizard 

on one page, or for 

nches so you can 
ail message. If you 
age as an e-mail file.
Scanning from scanner buttons

rview of scanner buttons

ist of buttons available on your scanner, see the "Front panel and accessories comparisons" on page 3.

Scan To 
Scan to the HP Precisionscan Pro software. View the image or make adjustments, such
resolution or resizing. If your scanner also has a Select Destination button (some mode
Scan To button, you can select and scan to other programs on your computer.

Select Destination (some models only)
Press this button up or down to choose a program, then press the Scan To button. The S
the item using settings optimized for that destination and sends the scan to that destina

Share-to-Web (some models only)
Scan a photo and send it to the HP Share-to-Web wizard on your computer. The HP Sh
uploads the image to a website.

Photo Reprint
Scan a photo and send it to the HP Photo Printing software for printing multiple photos 
creating photo album pages. 

E-mail
Scan using settings optimized for e-mail. The e-mail program window automatically lau
compose your message. The scanned image becomes a file attachment in the new e-m
do not have a supported e-mail program, this button allows you to save the scanned im
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play shows the 

ttings are used. Only 
cent to the currently 

 scanner. If your 
ptions program on 

.

ns from the HP 

ator light near the 
he scanner or start a 
to TOC Scann

Copy
Print copies using settings optimized for printing. At the computer, you can click Cancel
copy settings in the HP Scanjet Copy Utility before the pages print.

Number of copies (some models only)
Choose the number of copies before pressing Copy. The liquid crystal display (LCD) dis
number of copies selected.

Color/Black & White copy (some models only)
Choose the color or black and white setting before pressing Copy to ensure the best se
use color copy if you are printing to a color printer and want a color copy. The light adja
selected choice is lit.

More Options (some models only)
Open the dialog box to change settings, such as output quality, for some buttons on the
scanner does not have this button, change button settings with the HP Scanjet Button O
your computer. See "To change settings for buttons or update destinations" on page 34

Cancel (some models only)
Cancel a scan while the scanner is in the process of scanning, or cancel a series of sca
Scanjet Automatic Document Feeder (ADF).

Power Save
Puts the scanner in an energy-conservation mode. The scanner lamp and a small indic
Power Save button turn off. To use the scanner, press any button on the front panel of t
scan from the computer. The scan begins when the lamp is ready.
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 Precisionscan Pro 

ton ( ), you send directly to the HP 
sing the HP Precisionscan Pro software, 
es and make changes to the images 
tination or file them. 

n Pro software
o other program name displays in the 

 the LCD window reads Ready. (Some 
and accessories comparisons" on 
me displays, press the Select 
 or down until HP Precisionscan is listed 

y Utility program if it is open on your 

n on the scanner glass and close the lid. 
ee "Scanning from the ADF" on 

n the front panel of the scanner.
P Precisionscan Pro software. A 

rs in the Precisionscan Pro software 

anning from HP Precisionscan Pro" on 
Scanning from scanner buttons

nning quickly with scanner 
tons

e scanner buttons to scan quickly to a destination using settings 
ed for that destination. A destination is a printer, file, or 

m, such as your e-mail or word-processing program.
are scanning slides or negatives using the HP Scanjet 
arency Adapter (XPA), you must scan from the HP 

ionscan Pro software. See "Scanning from the XPA" on 
7.

Scanning to the HP
software

When you use the Scan To but
Precisionscan Pro software. U
you can preview scanned imag
before you send them to a des

To scan to the HP Precisionsca
Before you begin, make sure n
scanner�s LCD window or that
models only, see "Front panel 
page 3). If another program na
Destination button ( ) up
in the scanner�s LCD window.
1 Close the HP Scanjet Cop

computer.
2 Place the original face dow

To load items in the ADF, s
page 76.

3 Press the Scan To button o
4 Your computer opens the H

preview of the scan appea
window.

For more information, see "Sc
page 39.
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 about updating the destinations for 
, see "Changing settings for buttons" on 

s not have a Select Destination 
can To button, you can scan to 
ugh the HP Precisionscan Pro 
ding to a program" on page 61.
to TOC Scann

ing to another program

e models, you can select from a list of destinations (including 
recisionscan Pro software) on the front panel LCD display, 
n directly to the selected destination.
u select a program other than HP Precisionscan Pro using the 
estination button ( ), the scanner will automatically use 

 optimized for the destination you choose. You do not view or 
scanned images before they go to the destination.

 directly to another program
e the HP Precisionscan Pro and HP Scanjet Copy Utility 
rams if they are open on your computer.
e the original face down on the scanner glass and close the lid. 
ad items in the ADF, see "Scanning from the ADF" on 
76.

ur scanner has a Select Destination button next to the Scan To 
n ( ), press the Select Destination button up or down until 
estination you want to scan to is listed in the scanner�s LCD 
ow.
s the Scan To button on the front panel of the scanner.
item is scanned using settings optimized for the program you 
cted. The program launches and the scan is sent to the 
ram.

Note: For information
scanner buttons
page 34.

Tip If your scanner doe
button next to the S
other programs thro
software. See "Sen
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n Pro and HP Scanjet Copy Utility 
on your computer.
n on the scanner glass and close the lid. 
ee "Scanning from the ADF" on 

utton on the front panel of the scanner. 
 using settings optimized for the Web. 
P Share-to-Web wizard. 

he screen to finish posting the scanned 

s not have a Share-to-Web 
web using your HP 
oftware. See "Placing a scan on 
64.
Scanning from scanner buttons

ing a scan to a website

e models, you can share images with other people by scanning 
 to the Web with the Share-to-Web button ( ). People you 
an view photos and other items by visiting your website, which 

ve its own address.

To place a scan on a website
1 Close the HP Precisionsca

programs if they are open 
2 Place the original face dow

To load items in the ADF, s
page 76.

3 Press the Share- to- Web b
The scanner scans the item
Your computer opens the H

4 Follow the instructions on t
image to your website.

Tip If your scanner doe
button, scan to the 
Precisionscan Pro s
a website" on page
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 Quick Reference Guide
e is available in English only in some 
uage, press the Photo Reprint button 
 then click Quick Reference Guide.
to TOC Scann

ing for photo reprints

 scan photographs and prepare them for photo reprints by 
e Photo Reprint button ( ). Photo reprints optimize the 
hoto paper, allowing you to print multiple photos on one page. 
 also create pages with multiple photographs for projects such 
 albums. 
mputer, use the HP Photo Printing software provided with 
nner to arrange photographs, make adjustments, and print 
phs.

e a photo reprint
e the HP Precisionscan Pro and HP Scanjet Copy Utility 
rams if they are open on your computer.
e the original face down on the scanner glass and close the lid.
s the Photo Reprint button on the front panel of the scanner. 
scanner scans the item using settings optimized for 
ograph printing. Your computer opens the HP Photo Printing 
are. 

To view the HP Photo Printing
The HP Photo Printing softwar
countries. For help in your lang
on the scanner, click Help, and
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ow the scanner to scan an item as a file 
essage. If a scanned image 
 attachment in a new e-mail message, 
ted.

s
d e-mail program, such as the Web-
ail®, the scanner cannot scan items 

e. The scanner prompts you to save the 
he item with settings optimized for 
e the file, be sure to select the file type 
ge as a file, open an e-mail message 
ally do.
, make sure that E-mail File is selected 
 options.

ttons" on page 34 to check or change 
 the default, or to set E-mail File as the 

Tip
Scanning from scanner buttons

ing a scan using e-mail

you send e-mail using the E-mail button ( ), the scanner 
the item using default settings optimized for mailing. If you have 
orted e-mail program, the scanned image automatically appears 
e attachment in a new e-mail message, which you then address 
nd. If your e-mail program is not supported, choose E-mail 
y. The computer prompts you to save the item as a file, and then 
nner completes the scan. Open your e-mail program and attach 
 to a message as you normally do.

ote: When prompted to save the file, be sure to select the 
file type you want. 

Supported e-mail programs
Supported e-mail programs all
and attach it to a new e-mail m
automatically appears as a file
your e-mail program is suppor

Unsupported e-mail program
If you are using an unsupporte
based program Microsoft Hotm
directly into an e-mail messag
item as a file and then scans t
e-mail. (When prompted to sav
you want.) After saving the ima
and attach the file as you norm
To be prompted to save the file
as the destination in the button
See "Changing settings for bu
which e-mail program is set as
default.

To view the scanned item before you send it, open 
the file attachment from the new e-mail message.



Back ing from scanner buttons 31

To e-ma
1 Clos

prog
2 Plac

To lo
page

3 Pres
4 If the

Doc
"Sel

5 If yo
prom
nam
If the
nam
e-ma

ment without using an ADF, the 
 for another page. Do one of the 

 pages to scan, click Done.
ges of this item, load the next page and 
 all pages are scanned. Then, click 

ure off, see "To change settings for 
te destinations" on page 34.

mail program, the scanned image 
 file attachment in a new message. 
send it as you normally do. If you do not 
rogram, the computer confirms that the 
n your e-mail program and attach the 
to TOC Scann

il a scan from the scanner
e the HP Precisionscan Pro and HP Scanjet Copy Utility 
rams if they are open on your computer.
e the original face down on the scanner glass and close the lid. 
ad items in the ADF, see "Scanning from the ADF" on 
76.

s the E-mail button on the scanner.
 computer prompts you for the original type, select Photo or 

ument. If you need help choosing the original type, see 
ecting original type for e-mail" on page 32.
u do not have a supported e-mail program, the computer 
pts you to save the image as a file. In the Save As dialog box, 

e the file, choose a location in which to save it, and click Save. 
 computer prompts you for an attachment file name, enter a 
e in the File name box. If you need more help, see "Naming 
il attachments" on page 32.

6 If you are scanning a docu
computer may prompt you
following:
� If you do not have more
� If there are additional pa

click Scan. Repeat until
Done.

Note: To turn this feat
buttons or upda

7 If you have a supported e-
automatically appears as a
Address the message and 
have a supported e-mail p
item is saved to a file. Ope
saved file.
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To turn
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each time for a filename. If you do not 
want the scanning software to assign an 
y, check the box labeled In the future, 
Do not prompt me.
rompt back on, see "Changing settings 

type for the e-mail attachment. A photo 
e type. A document original type results 

ave the item as a file type other than .jpg 
d save the item using the HP 
ro software. See "To save to a file" on 
Scanning from scanner buttons

ng original type for e-mail
oftware prompts you for an original type, you have two choices, 
or Document. The scanner will use optimized scan settings for 
em depending on your choice. Use the following guidelines to 
ine the best original type for your needs:

lect Document if the item contains text or both text and graphics. 
is produces a .pdf file.

lect Photo if the item is a printed photograph or image 
gatives and slides not supported).  This produces a .jpg file.

frequently scan the same type of original, and do not want the 
l Type screen to appear each time, you can turn it off. To do so, 
 Photo or Document, then check the box labeled In the 

, use this setting. Do not prompt me.
 the original type prompt back on, see "Changing settings for 

s" on page 34.

Naming e-mail attachments
The computer will prompt you 
want to be prompted, and you 
attachment name automaticall
name the file automatically. 
To turn the attachment name p
for buttons" on page 34.
Save as type displays the file 
original type results in a .jpg fil
in a .pdf file type.

Note: If you need to s
or .pdf, scan an
Precisionscan P
page 62.
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n Pro program if it is open on your 

n on the scanner glass and close the lid. 
ee "Scanning from the ADF" on 

ront panel and accessories 
On the scanner, select color or black 

ront panel and accessories 
On the scanner, select the number of 
 is one copy.
he scanner. Unless you click Cancel, 
ified in the scanner LCD window will 
printer.
pies, lighten or darken them, or change 
lick Cancel on the computer to set 
opy Utility. Change options and click 

sn�t have buttons to select color 
or number of copies, use the HP 
.

to TOC Scann

ng copies

 scan an item and send it to a printer to make copies using the 
tton ( ). Note that when you make copies, each page is 
s a separate print job, so the printer will not collate copies.

To print copies from the scann
1 Close the HP Precisionsca

computer.
2 Place the original face dow

To load items in the ADF, s
page 76.

3 (Some models only, see "F
comparisons" on page 3.) 
and white copies.

4 (Some models only, see "F
comparisons" on page 3.) 
copies. The default setting

5 Press the Copy button on t
the number of copies spec
print directly to the default 

6 To reduce or enlarge the co
which printer prints them, c
options in the HP Scanjet C
Copy.

Tip If your scanner doe
or black and white, 
Scanjet Copy Utility
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 "Front panel and accessories 
.) On the scanner, press the More 

t to Programs, point to HP Scanjet 
canjet Button Options.
s you want to change.
 change the settings and click OK.
s, click Update. The software 
r computer for supported new programs 
utton destinations. When the update is Tip
Scanning from scanner buttons

nging settings for buttons 

you use the scanner buttons, the scanner scans the item using 
s optimized for the destination, such as e-mail, that is 
ated with that button. You can change the default settings for 
scanner buttons. Settings are applied to all items being scanned 
u manually change the settings. You can also update the 
r button destinations to include new programs on your 
ter.

To change settings for buttons
1 Do one of the following:

� (Some models only, see
comparisons" on page 3
Options button ( ).

� On the Start menu, poin
Utilities, and click HP S

2 Click the tab for the option
3 For the E-mail tab options,
4 For the General tab option

automatically searches you
and updates the scanner b
complete, click OK.

To change the settings only for the current item, you 
might want to scan using the HP Precisionscan Pro 
software instead. See "Scanning from HP 
Precisionscan Pro" on page 39.



Back ing from scanner buttons 35

To resto
1 Do o

� (S
co
O

� O
U

2 Click
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canner buttons

 options that are applied to items you 
).

which scanned images will be placed as 
ted. If no compatible e-mail programs 
you cannot scan directly to e-mail. 
e in the Destination field. Then when 

) on the scanner, you will be 
 image as a file, which you can manually 
s you normally do.
 does not appear in the list, you can use 
eneral tab to update the destination list 
a newly released e-mail program, check 
e HP support website for new drivers to 
therwise, visit the page for this scanner 
heck for known conflicts with the 

t:
rt
to TOC Scann

re default E-mail button options
ne of the following:
ome models only, see "Front panel and accessories 
mparisons" on page 3.) On the scanner, press the More 

ptions button ( ).
n the Start menu, point to Programs, point to HP Scanjet 
tilities, and click HP Scanjet Button Options.
 the E-mail tab.
 Restore Defaults, then click OK.

List of options for s

E-mail tab options 
This tab contains the scanning
scan using the E-mail button (
Destination
Select the e-mail program into 
files when scanning is comple
are installed on the computer, 
Instead, select E-mail File her
you press the E-mail button (
prompted to save the scanned
attach to an e-mail message a
If the e-mail program you want
the update button under the G
for the E-mail button. If this is 
the page for this scanner on th
support the e-mail program. O
on the HP support website to c
program you want.
Visit the HP support website a
http://www.hp.com/go/suppo

http://www.hp.com/go/support
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ument original types only. Check the 
t to scan additional pages when ADF 

rompt to add more pages to the current 
l if you scan documents without an ADF 
ingle .pdf file attachment. Uncheck the 
t to scan additional pages when ADF 
this option off.

to original types only. Choose one:

 on the scanner bed automatically 
 scanner bed.

scans the full size of the scanner bed 

 quality creates scans at 75 dpi.

00 dpi.

uality creates scans at 150 dpi.

 True Color. For black and white 
le.

to original types only. To retain color 
 the Scan in color box. To scan images 
can in color box.
Scanning from scanner buttons

al type
e one:

oto
cument
ompt for original type each time
ault, the original type is set to Prompt for original type each 
f you scan a variety of original types, this allows you to make the 
l type choice each time. Use Photo or Document if you are 
ntly scanning the same type of original.
t for e-mail attachment name

 the Prompt for e-mail attachment name box to enter a name 
ime for e-mail attachments. Uncheck the Prompt for e-mail 
ment name box if you want the scanning software to assign an 
ment name automatically.
al size
ption is available for Document original types only. Select the 
at most closely matches the item you are scanning. Some 
rs support an optional automatic document feeder (ADF) that 

 you to scan pages larger than the scanner glass.
y (for documents)
ption is available for Document original types only. Choose one:

all file size with lower quality creates black and white scans 
100 dpi. 

rmal creates grayscale scans at 200 dpi.

rge file size with high quality creates color scans at 300 dpi. 

e type is .pdf.

Prompt to scan additional pa
This option is available for Doc
When done scanning, promp
is not being used box for a p
document. This option is usefu
and want multiple pages in a s
When done scanning, promp
is not being used box to turn 
Area to scan
This option is available for Pho

� Scan only items detected
crops a photograph on the

� Scan entire scanner bed 
without cropping.

Quality (for photos)
Choose one:

� Small file size with lower
� Normal creates scans at 1

� Large file size with high q
For color photos, output type is
photos, output type is Graysca
Scan in color
This option is available for Pho
when scanning images, select
in black and white, clear the S

http://www.hp.com/go/support
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 ) to conserve energy when you are 
ou press the Power Save button, the 
cator light near the Power Save button 
returns to its starting position.  
s any button on the front panel of the 
e computer. After a short warm-up 

els a scan in progress. When you press 
n, the lamp shuts down and returns to 
s the Cancel button during a scan from 
ages that are in the process of scanning.
to TOC Scann

l tab options
stall a new software program on your computer after you install 
canning software, update the scanner button destinations 

e General tab options. An update ensures that the scanner 
can send to supported new destinations on your computer. In 
 update the destinations, your scanner must be attached to the 
r before you press Update.

eneral tab, click Update. The software automatically searches 
puter for supported new programs and updates the scanner 

estinations. When the update is complete, click OK.

e: If your scanner has a Select Destination button next to 
the Scan To button, not all destinations appear in the 
scanner�s destination list. For example, printers, e-mail 
programs, and saving to a file are not included. The list 
is also limited to the first 18 destinations found by the 
HP scanning software. You can access additional 
destinations through the HP Precisionscan Pro 
software. See "To send to a program" on page 61 for 
more information.

Power Save
Use the Power Save button (
not using the scanner. When y
scanner lamp and a small indi
turn off and the scanner lamp 
To use the scanner again, pres
scanner or start a scan from th
cycle, the scan begins.
Cancel (some models only)
The Cancel button (  ) canc
the Cancel button during a sca
its starting position. If you pres
the ADF, the ADF ejects any p
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e HP Precisionscan 

tware provides preview capabilities and 
ome of the changes you can make 

, the preview image to become the final 

.

to TOC

Scanning from HP Precisionscan

e HP Precisionscan Pro software, you can preview scanned 
and make changes to the images before you send them to a 
ion or file them. You start the HP Precisionscan Pro software 
canner button or the Programs group in the Start menu.
 also start the HP Precisionscan Pro software from another 
, such as a word-processing or image-editing program, if the 
 is compliant with TWAIN. See "Scanning from other programs 
)" on page 71 for more information.

Overview of th
Pro software

The HP Precisionscan Pro sof
tools for changing an image. S
include:

� Select only part of, or crop
scanned image.

� Change the resolution.

� Resize the scanned image

� Change the contrast.
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ail to send the scanned image, a Smart 
 file will probably be too large for e-mail. 
f, select the Don�t remind me again 
alog box. To turn all messages off, click 
 the Help menu. To turn all messages 
rt Friends.

use source of information about using 
bleshooting, support, and specifications. 
 the Help menu, click Contents. Or, 
log box in which it appears.

e for computers running Internet 
 4.0 or greater. See "Resolving issues 

erate messages" on page 87.

enu, or command to find more 
Scanning from HP Precisionscan Pro

ting the HP Precisionscan Pro software

t the HP Precisionscan Pro software, press the Scan To button 
, or on the Start menu, point to Programs, and click HP 
ionscan Pro. The software starts.
 the function of a command, place the cursor over the 

and until an explanation appears.
re information about the types of assistance the software itself 

 see �Finding help for using the software� on this page. For more 
ation about keyboard shortcuts, menu items, toolbars, and 
 appearance, see "Using software commands and controls" on 
09.

ing help for using the software

P Precisionscan Pro software provides a variety of assistance.

d Steps
e Guided Steps for step-by-step help as you move through the 
ng process. By default, the Guided Steps appear along the left 
 the preview window. As you become more comfortable with the 
re, you can hide them. To show or hide the Guided Steps, on 
w menu, click Guided Steps. Or, on the toolbar click . 

ote: Help is available for computers running Internet 
Explorer version 4.0 or greater. See "Resolving issues 
that did not generate messages" on page 87.

Smart Friends
Smart Friends are tips that app
potential problems. For examp
resolution but want to use e-m
Friend would alert you that the
To turn individual messages of
check box in the message�s di
Disable All Smart Friends on
back on, click Enable All Sma

Online Help
The online Help is an easy-to-
the scanner and software, trou
To gain access to the Help: on
click the Help button in any dia

Note: Help is availabl
Explorer version
that did not gen

What�s This? Help
Click  and click a button, m
information about that feature.
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Perf

Once yo
item and
software
necessa

To start 
Use the
software
with sca
1 Plac

Not

2 On t
Prec

se ways:
 Pro software, click  on the toolbar 
isible).
 Pro software, click New Scan on the 

 the HP Precisionscan Pro software. 
view image. You can make changes, 
he image or adjusting the contrast. 
nother program such as e-mail, place 
e it as a file, the scanner performs a final 
any changes you made. Directions for 
nd completing the scan appear in this 
to TOC Scanning fr

orming a new scan 

u start a new scan, the scanner does a preliminary scan of the 
 displays the scanned image in the HP Precisionscan Pro 
. Then, you can see the scanned image and edit it, if 
ry, before sending it to a destination or saving it as a file.

a new scan
se steps to start a scan from the HP Precisionscan Pro 
. To start a scan from a scanner button, see "Scanning quickly 
nner buttons" on page 26.
e the original face down on the scanner glass and close the lid. 

e: To load items in the HP Scanjet Automatic Document 
Feeder (ADF), see "Scanning from the ADF" on 
page 76.

he Start menu, point to Programs, and click HP 
isionscan Pro. The software starts.

3 Start the scan in one of the
� In the HP Precisionscan

or the Guided Steps (if v
� In the HP Precisionscan

Scan menu.
The scanned image appears in
This scanned image is the pre
such as selecting only part of t
When you send the image to a
the image on a website, or sav
scan of the item that includes 
making optional adjustments a
section.
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Cro
fina

Once a
you m
creatin
selecti

For inf
area o
page 1

inal scan

e area you want and click.
ike this: , click on one corner of the 
 the cursor to the opposite corner to 
tion area.

 Select All. The entire scanner bed, 
 selected. 

ion border and drag to change the 

tion area. When the cursor looks like 
lection border to the new location.

r 

select All.

Tip

sel
bor
Scanning from HP Precisionscan Pro

pping or selecting an area for 
l scan

 scanned image appears in the HP Precisionscan Pro software, 
ust select which area becomes the final scanned image by 
g a selection area. When you create a selection area, a dotted 
on border appears around the area:

ormation about the appearance of the cursor when it is over an 
f the selection border, see "Context-sensitive cursors" on 
16.

To crop or select an area for f
Do one of the following:

� Move the cursor over th
� When the cursor looks l

area you want and drag
draw a rectangular selec

� On the Edit menu, click
including blank areas, is

To change the selection area 
Click on a handle of the select
selection area.

To move the selection border
Move the cursor over the selec
this: , click and drag the se

To remove the selection borde
Do one of the following:

� Press ESC.

� On the Edit menu, click Un

If you only want to look more closely at an area 
without changing what will be included in the final 
scan, see "Getting a closer look (zooming)" on 
page 43.

ection 
der
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Gett

Zoom in
changes
can sele
selection
provides
if you ha
Zooming
the final
dimensi
scanned
page 42
page 45

To zoom
After cre

� On t

� Click

To zoom
Do one 

� On t
the i

� Click

t type 

e is selected, the scanning software 
ut type based on the type of item you 
n change the output type yourself when 

ype based on how you will use the final 
type of item you are scanning.

d, click Automatically Set Type on the 
llow the software to choose the best 
of original item. 
e only for this scan, keep 
 selected and select an output type you 

ype menu. See "List of output types" on 

e for this scan and all other scans in 
atically Set Type and select an output 
utput Type menu. See "List of output 

n output type, view the Guided 
t already displayed, click . In 

t the output type is what you 
e Choose.
to TOC Scanning fr

ing a closer look (zooming)

 on the selection area to look at it more closely or make 
 to it. Zoom out to view the entire preview image, or so you 
ct a different area of the image to view. Zooming in on the 
 area before making changes or performing a final scan 
 the best final results. The zoom commands are not available 
ve not created a selection area.
 in and out does not change which part of the image becomes 

 scan, nor does it change the final output size (physical output 
ons). To change which part of the image becomes the final 
 image, see "Cropping or selecting an area for final scan" on 
. To resize the image, see "Resizing (output dimensions)" on 
.

 in 
ating a selection area, do one of the following:

he View menu, click Zoom in. 

 .

 out 
of the following:

he View menu, click Zoom out to return to the original view of 
mage.

 .

Selecting outpu

When Automatically Set Typ
automatically chooses an outp
are scanning. However, you ca
you want. Choose the output t
scanned image as well as the 

To select an output type
1 Do one of the following:

� If it is not already selecte
Output Type menu, to a
output type for this type 

� To change the output typ
Automatically Set Type
want from the Output T
page 44.

� To change the output typ
this session, clear Autom
type you want from the O
types" on page 44.

Tip For help choosing a
Steps. If they are no
step 3 �Confirm tha
want,� select Help M
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List of 
ck Automatically Set Type. The 
put type based on the image inside the For th

Color 
� pr
� dis
� dis

fo

Color 
� pr
� se
� us
� vie

Color 
B&W p

B&W p
purpos

B&W d
progra

B&W d
progra

Any im
Web.

Text th

Text th

Color 
conce
for any
Scanning from HP Precisionscan Pro

output types To reset output type
On the Output Type menu, cli
software chooses the best out
selection area.

ese uses Use this output 
type

photos or drawings with lots of shading to be:
inted on a color printer.
played on a color monitor set to millions of colors.
played on the Web and saved in the .jpg or .png file 

rmat.

True Color 
(16.7 million 
colors)

photos or drawings with shading to be:
inted to a color printer.
nt via e-mail.
ed in any way that requires a small file size.
wed on a computer screen.

256-Color 
(optimized palette)

photos or drawings with shading to be printed to a 
rinter.

Grayscale

hotos and drawings with shading to be used for any 
e.

Grayscale

rawings without shading to be placed in another 
m without resizing in the other program.

Black & White 
Bitmap

rawings without shading to be resized in another 
m.

Black & White 
Scalable

age to be saved in .gif file format and displayed on the 256-Color (web 
palette) 

at needs to be editable in a word-processing program. Editable Text 
(OCR)

at needs to be editable and graphics to be used. Text and Image

drawings or logos without much shading and with a 
ntrated area of a single color. The image is to be used 
 purpose.

Spot Color (16-
color)
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Mak
basi

These to
Depend

Resiz

You can
output d
dimensi
the best

esize. The Resize dialog box opens.

it of measure in the Units field. In the 
, type a new value in the Width or 
NTER.
 a scale percentage.
cale, Width, and Height fields, but the 
ned image on screen remain the same. 

 complete the scan.
 locks the output dimensions you 
 the selection area without changing the 
you change the selection border, the 
r proportionally. The output dimensions 

Tip
to TOC Scanning fr

ing optional adjustments, 
c

ols are needed most often, but using any of them is optional. 
ing on the output type chosen, some tools will not be available.

ing (output dimensions)

 resize the image before you do the final scan by changing the 
imensions. Resizing the scanned image to the actual 
ons you need before performing the final scan helps ensure 
 image quality.

To resize an image
1 On the Tools menu, click R
2 Do one of the following:

� If necessary, select a un
Output Dimensions area
Height field and press E

� In the Scale field, select
New values appear in the S
selection area and the scan
Resizing occurs when you

3 If you want, click . This
defined so you can change
output dimensions. When 
software resizes the borde
remain the same.

If you need to resize images to fit in a file, such as a 
word-processing document, resize them here in the 
scanning software. Resizing images in the other 
program can cause them to be fuzzy or have jagged 
edges.
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Cha

Resolu
scanni
type. T
If you 
capab
scanne
for bla
graysc
keepin
Select
not inc
quadru
such a
For he
destina

To cha
1 On
2 Do

�

�

The re

nge Resolution. Then, click .

e midtone, highlight, and shadow 
nes" on page 50, "Changing highlights" 
adows" on page 52.

ange Resolution tool to the 
d Change Resolution and 
 toolbar" on page 114.
Scanning from HP Precisionscan Pro

nging resolution 

tion determines the amount of data in a scanned image. The 
ng software chooses the optimal resolution based on the output 
his resolution generally does not need to change. 

do change the resolution, choose one no higher than the 
ilities of the monitor or printer and one appropriate for the type of 
d image. For example, to print on a 600 dpi printer, choose 600 

ck and white bitmap images, but choose only 200 for color or 
ale images. These resolutions produce optimal quality while 
g file sizes small.
ing higher resolutions for color images increases file size while 
reasing quality. If you double the resolution, the file size 
ples. Large file sizes can prevent you from doing certain tasks, 
s e-mailing, or can take up too much space on your computer.
lp choosing a resolution based on the type of original item and 
tion, see "Tips for best image quality" on page 67.

nge resolution
 the Tools menu, click Change Resolution.
 one of the following:
Select a value from the list.
Type a value between 12 and 999,999 in the field and press 
ENTER.
solution changes as soon as you select a value.

To reset resolution
On the Tools menu, click Cha

Changing contrast

The contrast is controlled by th
settings. See "Changing midto
on page 51, and "Changing sh

Tip You can add the Ch
toolbar. See "To ad
Sharpen tools to the
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Rotat

You can
counterc
bottom o
sideway
sideway

To rotate
Do one 

� To ro
righ

� To ro
Rota
turni

g) an image

image from side to side on the vertical 
s you to see the elements of the image 
tual position. Mirroring can be 

ch as negatives that might be placed in 
canned in reverse.

or. Repeat to return to the original 

Tip

ed images with the output types 
and Image, and Black & White 
images with these output types 
 image.
to TOC Scanning fr

ing an image

 rotate the image in 90-degree increments clockwise or 
lockwise. You might need to rotate the image if you placed the 
f the item at the top of the scanner glass, or if the item was 
s. Items such as negatives in their template often scan 
s.

 an image
of the following:

tate an image clockwise: On the Tools menu, click Rotate 
t 90°. Or, click  on the toolbar. Repeat to continue turning.

tate an image counterclockwise: On the Tools menu, click 
te left 90°. Or, click on the toolbar. Repeat to continue 
ng.

Mirroring (reversin

You can mirror, or reverse, an 
axis. Mirroring an image allow
on the opposite side of their ac
particularly useful for items su
their template backward and s

To mirror (reverse) an image
On the Tools menu, click Mirr
layout.

Do not rotate scanned images with the output types 
Editable Text, Text and Image, and Black & White 
Scalable. Rotating images with these output types 
results in a distorted image.

Tip Do not mirror scann
Editable Text, Text 
Scalable. Mirroring 
results in a distorted
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Shar

Increa
HP Pre
sharpe
You m
Conve
has fla
much,

To sha
1 On
2 Se

the

To rese
1 On
2 Cli

ments 

timal (default) values the scanning 
Optimal values are based on the output 
ves all adjustments you have made 
evel, or the selection area. 

set Tools.

Tip
Scanning from HP Precisionscan Pro

pening an image

sing sharpening enhances detail in the image. The 
cisionscan Pro software automatically selects the optimal 
n level, but you can change it.
ight want to increase sharpening if the image looks fuzzy. 
rsely, you might want to decrease sharpening if the original item 
ws or marks on it. Increasing sharpening, or increasing it too 
 can accent the flaws and create undesirable patterns. 

rpen an image
 the Tools menu, click Sharpen.
lect a sharpen level from the list. The viewer shows the effect of 
 changes on the image.

t sharpen levels
 the Tools menu, click Sharpen.
ck .

Resetting all adjust

You can reset images to the op
software chose for the image. 
type selected. Resetting remo
except the output type, zoom l

To reset all adjustments
Do one of the following:

� On the Edit menu, click Re
� On the toolbar, click .

You can add the Sharpen tool to the toolbar. See 
"To add Change Resolution and Sharpen tools to 
the toolbar" on page 114.
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Mak
adva

These o
not use 
effects o
tools are

nvert white areas of an image to black 
ages, a color is converted to its 

ly, this command is useful for drawings 

 Invert Colors. Repeat to reverse the 
to TOC Scanning fr

ing optional adjustments, 
nced

ptional adjustments are ones that most people generally do 
or need, but some advanced users might want them for special 
r other needs. Depending on the output type chosen, some 
 not available.

Inverting the image

Use the Invert command to co
and black to white. For color im
complementary color. General
and spot color images.

To invert the image
On the Advanced menu, click
colors again. 
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Cha

The m
image
Moving
image
To adju
use "A

lick Adjust Exposure.

to the right.
 the Midtone field and press ENTER.
to the Midtone field.

lick Adjust Exposure.

to the left.
the Midtone field and press ENTER.
ext to the Midtone field.

s
lick Adjust Exposure.
dtone, highlight, and shadow to the 
nned image. Clicking Auto also returns 
s. See "Setting pixel output levels" on 

Tip
Scanning from HP Precisionscan Pro

nging midtones

idtone setting lets you lighten or darken the middle values in an 
. The range for the number in the Midtone field is 1.0 to 4.0. 
 toward 1.0 darkens the image. Moving toward 4.0 lightens the 

. 
st midtones for slides, negatives, or other transparent items, 

djusting midtones for slides or negatives" on page 81.

To lighten the image overall 
1 On the Advanced menu, c
2 Do one of the following:

� Drag the Midtone slider 
� Type a higher number in
� Click the Up arrow next 

To darken the image overall
1 On the Advanced menu, c
2 Do one of the following:

� Drag the Midtone slider 
� Type a lower number in 
� Click the Down arrow n

To return to the default setting
1 On the Advanced menu, c
2 Click Auto to return the mi

default settings for this sca
output levels to the default
page 54.

If you are sharing the image with others who will be 
viewing it on a computer screen, the Midtone value 
of 2.2 is recommended because it is an average 
value that works with many different monitors.

Midtone set at 2.2
(the default)

Midtone set at 3.0
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Chan

The high
screen a
white. 
The ima
makes m
areas. S
distinct, 
To adjus
use "Ad

eas 
lick Adjust Exposure.

 toward the right.
 the Highlights field and press ENTER.

to the Highlights field.

reas
lick Adjust Exposure.

 toward the left.
the Highlights field and press ENTER.
xt to the Highlights field.

light value
When the cursor changes to the 
rea you want to be the highlight and 

s
lick Adjust Exposure.
dtone, highlight, and shadow to the 
nned image. Clicking Auto also returns 
s. See "Setting pixel output levels" on 

Hig
to TOC Scanning fr

ging highlights 

light is the value in the image that is represented on the 
s white. All values lighter than the highlight also appear as 

ge has a default highlight setting. Selecting a higher number 
ore of the lighter values distinct, which increases detail in light 

electing a lower number makes fewer of the lighter values 
which reduces detail in the light areas. 
t highlights for slides, negatives, or other transparent items, 
justing highlights for slides or negatives" on page 82.

To increase detail in lighter ar
1 On the Advanced menu, c
2 Do one of the following:

� Drag the Highlight slider
� Type a higher number in
� Click the up arrow next 

To decrease detail in lighter a
1 On the Advanced menu, c
2 Do one of the following:

� Drag the Highlight slider
� Type a lower number in 
� Click the down arrow ne

To choose a value as the high
Click  (white eyedropper). 
eyedropper, move it over the a
click.

To return to the default setting
1 On the Advanced menu, c
2 Click Auto to return the mi

default settings for this sca
output levels to the default
page 54.

hlights set at 215 Highlights set at 122
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Cha

The sh
as blac
The im
makes
dark a
values
To adju
use "A

reas 
lick Adjust Exposure.

r toward the left.
the Shadows field and press ENTER.
xt to the Shadows field.

reas
lick Adjust Exposure.

r toward the right.
 the Shadows field and press ENTER.

to the Shadows field.

w value
hen the cursor changes to the 

ea you want to be the shadow and click.

s
lick Adjust Exposure.
dtone, highlight, and shadow to the 
nned image. Clicking Auto also returns 
s. See "Setting pixel output levels" on 
Scanning from HP Precisionscan Pro

nging shadows 

adow is the value in the image that is represented on the screen 
k. All values darker than the shadow also appear as black.
age has a default shadows value. Selecting a lower number 
 more of the darker values distinct, which increases detail in 
reas. Selecting a higher number makes fewer of the darker 
 distinct, which reduces detail in the dark areas. 
st shadows for slides, negatives, or other transparent items, 

djusting shadows for slides or negatives" on page 82.

To increase detail in darker a
1 On the Advanced menu, c
2 Do one of the following:

� Drag the Shadows slide
� Type a lower number in 
� Click the down arrow ne

To decrease detail in darker a
1 On the Advanced menu, c
2 Do one of the following:

� Drag the Shadows slide
� Type a higher number in
� Click the up arrow next 

To select a value as the shado
Click  (black eyedropper). W
eydropper, move it over the ar

To return to the default setting
1 On the Advanced menu, c
2 Click Auto to return the mi

default settings for this sca
output levels to the default
page 54.

Shadows set at 10 Shadows set at 3
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Check

The ligh
detail in
highligh
therefor
saturate
have no
You can
contain 

ight (highlight) areas
lick Adjust Exposure.
. The light areas in the image that will 
pear black.
lick the Up arrow repeatedly until the 

om the image. The result of the change 

 Highlight Alarm off.

ark (Shadow) areas
lick Adjust Exposure.

. The darker areas in the image that will 
il) appear white.
k the Down arrow repeatedly until the 
om the image. The result of the change 

 Shadow Alarm off.

No
to TOC Scanning fr

ing for clipped areas

test or darkest areas of an image that will print without any 
 them are known as clipped areas. The lightest areas, or 
ts, will print as the color of the paper (without ink or toner) and 
e will have no detail. The darkest areas, or shadows, will print 
d in the blackest color of ink or toner, and therefore will also 
 detail. 
 view and change clipped areas if you want those areas to 
detail when they print.

To view and change clipped l
1 On the Advanced menu, c
2 Click  (Highlight Alarm)

print as white (no detail) ap
3 In the Highlights setting, c

clipped pixels disappear fr
can be seen.

4 Click  again to turn the

To view and change clipped d
1 On the Advanced menu, c
2 Click  (Shadow Alarm)

print as black (without deta
3 In the Shadow setting, clic

clipped pixels disappear fr
can be seen.

4 Click  again to turn the

rmal view View when 
Highlight 
Alarm 
selected

View when 
Shadow 
Alarm 
selected
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Setti

The ou
picture
levels 
Decrea
Increa
Chang
value t
To cha
see th

lick Adjust Exposure.
eck box. The dialog box expands to 

nd Black output levels.
ne of the following:
r.
 in the White or Black field and press 

rrow next to the White field or Black 

tput levels can be seen in the preview 

s
lick Adjust Exposure.
dtone, highlight, shadow, and output 
s for this scanned image.

Tip
Scanning from HP Precisionscan Pro

ng pixel output levels

tput levels setting lets you create interesting effects for scanned 
s. When you select this command, the Black and White output 
appear. By default, white is set to 255, and black is set to 0. 
sing the White output level makes the overall image darker. 

sing the Black output level makes the image more faded. 
ing the White output level value to 0 and the Black output level 
o 255 inverts the colors in the image. 
nge the ranges for the numbers in the White and Black fields, 
e Controls tab of "Setting preferences" on page 68.

To change output levels
1 On the Advanced menu, c
2 Click the Output Levels ch

display the current White a
3 To change the levels, do o

� Click one side of a slide
� Type a different number

ENTER.
� Click the Up or Down a

field.
The result of the changes to ou
area.

To return to the default setting
1 On the Advanced menu, c
2 Click Auto to return the mi

levels to the default setting

To use an image as a light background for dark text, 
such as for an overhead transparency, increase the 
Black output level until the image is as faint as you 
want. 
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View

You can
graysca
To view 
transpar
page 83

To view 
1 On t
2 Click
3 Mov

appe

Not

4 Click
the c
to TOC Scanning fr

ing RGB values and pixels

 view the RGB values and pixel color for any spot in a color or 
le image using the RGB meter.
the RGB values and pixel color for slides, negatives, or other 
ent items, use "Viewing RGB values and pixel color" on 
.

the RGB values and pixels
he Advanced menu, click Adjust Exposure.
  or .

e the pointer over the image. The RGB values and pixel color 
ar in the RGB meter.

e: Do not click while the eyedropper pointer is over the 
image unless you want to change the setting for 
highlight or shadow.

 the same eyedropper button again. The RGB meter dims and 
ursor returns to normal.

RGB 
values Pixel 

color
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Abo

The hi
area. T
red lin
is not 

The tu
cursor
histogr

The hi
the fin
histogr
chang

ts hue and the saturation. Hue refers to 
age. 
n image, but you can change it. You 

mage has too much of one color, or if 
ffect.

lick Adjust Color.
f the 
following 

 to a new 

or on the 
.
e seen in 

s
lick Adjust Color.
default hue and saturation settings for 

 much of one color, move the 
y from that color.

Indicator circle

Arrows
Scanning from HP Precisionscan Pro

ut the histogram

stogram is a graph of the distribution of pixels in the selection 
he magenta line represents the current setting for shadow. The 

e represents the current setting for highlight. The midtone setting 
represented. 

rquoise line appears in the histogram when either eyedropper 
 is positioned over the image. This line shows you where in the 
am the pixels in that area of the image occur.

stogram represents pixel distribution in the preview image, not in 
al scanned image. Changing the selection area changes the 
am. Changing the setting for highlight or shadow does not 

e the histogram. 

Changing the hue

Color in an image consists of i
the overall color cast of the im
The software sets the hue for a
might want to change it if the i
you want to create a special e

To change the hue 
1 On the Advanced menu, c
2 Change the overall color o

image by doing one of the 
on the color wheel:
� Drag the indicator circle

area.
� Click the arrow for a col

outer edge of the wheel
The result of the change can b
the image.

To return to the default setting
1 On the Advanced menu, c
2 Click Auto to return to the 

this scanned image.

Shadow Highlight

Where pixels in the 
image under the 
eyedropper fall

Tip If the image has too
indicator circle awa
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Chan

Color in
refers to
The soft
You mig
vivid, or
0 to 150

To incre
1 On t
2 Mak

� C
� Ty
� C

lick Adjust Color.
oing one of the following:
der.
the Saturation field and press ENTER.
ext to the Saturation field.

s
lick Adjust Color.
default hue and saturation settings for 
to TOC Scanning fr

ging the saturation

 an image consists of its hue and the saturation. Saturation 
 the intensity of the colors. 
ware sets the saturation for an image, but you can change it. 
ht want to change it to make colors in the image more or less 
 to create a special effect. The range in the Saturation field is 
. 

ase saturation
he Advanced menu, click Adjust Color.
e colors more vivid by doing one of the following:
lick to the right of the slider.
pe a higher number in the Saturation field and press ENTER.

lick the Up arrow next to the Saturation field.

To decrease saturation
1 On the Advanced menu, c
2 Make colors less vivid by d

� Click to the left of the sli
� Type a lower number in 
� Click the Down arrow n

To return to the default setting
1 On the Advanced menu, c
2 Click Auto to return to the 

this scanned image.
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Cha

Chang
Black 
image
in the i
values
The im
zero m
makes

reshold 
hite Bitmap is selected on the Output 
should have a dot beside it.
lick Adjust Black & White.

 field and press ENTER.
rrow next to the field.

hold
lick Adjust Black & White.

(

Scanning from HP Precisionscan Pro

nging the black and white threshold

ing black and white threshold only applies to images using the 
& White Bitmap output type. The threshold is a value in the 
 that represents the border between black and white. All values 
mage that are lighter than the threshold appear as white, and all 
 darker appear as black.
age has a default threshold value. Choosing a number closer to 
akes more values appear as white. Choosing a higher number 
 more values appear as black. 

To change black and white th
1 Make sure that Black & W

Type menu. The selection 
2 On the Advanced menu, c
3 Do one of the following:

� Drag the slider.
� Type a new value in the
� Click the Up or Down a

To reset black and white thres
1 On the Advanced menu, c
2 Click Auto.Threshold at 127 

the default for this image)

Threshold at 45
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Settin
in bla

This pro
& White
correct f
Images 
amount 
determin
or white

lack or white in black & white bitmaps 
hite Bitmap is selected on the Output 
should have a dot beside it.
lick Adjust Black & White.
 the Scan using channel list.

the red in the image to white. Green and 
ful for originals printed on pink or red 

e the green in the image to white. Red 
 Useful for originals printed on green 

 the blue in the image to white. Red and 
eful for originals printed on blue paper.
onvert light shades of all colors to white 
lors to black. (No one color becomes all 

s are converted to gray at a ratio of 30% 
 blue.

hite Bitmap is selected on the Output 
should have a checkmark beside it.
lick Adjust Black & White.

the Scan using channel list.
to TOC Scanning fr

g which colors become black or white 
ck & white bitmaps

cedure only applies to color images that will be using the Black 
 Bitmap output type. It allows you to create special effects, or to 
or originals on colored paper.
consist of pixels. In color images, each pixel has a varying 
of Red, Green, or Blue to create its specific color. You can 
e whether the Red, Green, or Blue in each pixel turns to black 

 in the final scanned image.

To set which colors become b
1 Make sure that Black & W

Type menu. The selection 
2 On the Advanced menu, c
3 Select a color channel from

� Choose Red to change 
blue become black. Use
paper.

� Choose Green to chang
and blue become black.
paper.

� Choose Blue to change
green become black. Us

� Choose NTSC Gray to c
and dark shades of all co
white or all black.) Color
red, 59% green, and 11%

To reset to the default colors
1 Make sure that Black & W

Type menu. The selection 
2 On the Advanced menu, c
3 Choose NTSC Gray from 
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Desc

Use th
items y
moiré 
newsp
Note th
Descre
printed
scan s

To des
On the
turn it 

ments

timal (default) values the scanning 
Optimal values are based on the output 
ves all adjustments you have made 
evel, or the selection area.

set Tools.
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reening images

e Descreen command to reduce undesirable patterns in printed 
ou are scanning. An example of an undesirable pattern is a 

pattern, or the circles that often appear on pictures printed in 
apers.
at scanning takes longer when this command is selected. Use 
en only when you see undesirable patterns on the scan of a 
 original. When Descreen is turned on or off, a new preview 
tarts and image adjustments are reset.

creen images
 Advanced menu, click Descreen. Select the option again to 
off.

Resetting all adjust

You can reset images to the op
software chose for the image. 
type selected. Resetting remo
except the output type, zoom l

To reset all adjustments
Do one of the following:

� On the Edit menu, click Re
� On the toolbar, click .
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Com

When yo
by doing

� "Sen

� "Ret

� "Sav

� "Prin

� "Pla

� "Set

� "Cop

� "Dra

� "Dra
page

� "Sca

When yo
scan inc
you cho
Images 
them to 
another 
See "Sa

am

hanging the scanned image, you can 
it directly to a program such as e-mail. If 
ailable, save the image as a file and 
gram as you normally would.

k Scan To.
ided Steps (if visible), click .
e list and click Scan. 
ccepts multipage files, you might be 
ges to scan to this file. Do one of the 

, click Done.
of this item, load the next page in the 
on the computer. Repeat until all pages 
 Done.

s and displays the scanned image.

ord or another word-processing 
t appears inside a frame you do 
ck the frame border and click 
a similar command in the word-
. To prevent this from 

ture, see "Setting preferences" 
to TOC Scanning fr

pleting the final scan

u finish making changes, you need to complete the final scan 
 one of these tasks:

ding to a program" on page 61.

urning the image to a TWAIN program" on page 62.

ing to a file" on page 62.

ting" on page 64.

cing a scan on a website" on page 64.

ting the scanned image as wallpaper" on page 65.

ying and pasting into another program" on page 65.

gging-and-dropping into another program" on page 65.

gging-and-dropping to the Windows Desktop or a folder" on 
66.

nning to CD" on page 66.

u do any of these procedures, the scanner performs a final 
luding your changes before sending it to the program or printer 
ose, copying the image, or completing any other function. 
are not automatically saved as files if you print them, send 
a another program, or copy and paste them into a file in 
program. To use the scanned image again, be sure to save it. 
ving to a file" on page 62.

Sending to a progr

Once you finish viewing and c
perform a final scan and send 
the program you want is not av
insert it into the destination pro

To send to a program
1 Do one of the following:

� On the Scan menu, clic
� On the toolbar or the Gu

2 Choose a program from th
3 If the program you select a

asked if you have more pa
following:
� If this is a one-page item
� If there are more pages 

scanner and click Scan 
are scanned. Then, click

The destination program open

Tip If you send text to W
program and the tex
not want, double-cli
Remove Frame or 
processing program
happening in the fu
on page 68.



62 Back to TOC

Retu

If you 
perform
proced
"Scann

To retu
Do one

� On

� On

N

when you want to use the images again 
h file type to use, see "List of file types" 
st image quality" on page 67. For 
e "Glossary" on page 117.

k Save As. 
ided Steps (if visible), click .
 of file types" on page 63.
 for the file and click OK. 

ailable, more options are available for 
, change any options you want, and 

s on how you will use the file. And, some 
n certain output types are selected. 
Scanning from HP Precisionscan Pro

rning the image to a TWAIN program

started the scan from a TWAIN-compliant program, you can 
 a final scan and return the image to that program using this 

ure. For more information about scanning using TWAIN, see 
ing from other programs (TWAIN)" on page 71.

rn the image to a TWAIN program
 of the following:

 the Scan menu, click Return Image to.

 the toolbar or the Guided Steps (if visible), click .

ote: You can also complete a final scan using WIA. See 
"Scanning from other programs (WIA)" on page 72.

Saving to a file

Save scanned images as files 
later. For help deciding on whic
on page 63, or see "Tips for be
definitions of File types, see th

To save to a file
1 Do one of the following:

� On the Scan menu, clic
� On the toolbar or the Gu

2 Select a file type. See "List
3 Select a name and location
4 If the Options button is av

this file type. Click Options
click OK.

The file type you need depend
file types are not available whe
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List of fil
Image f
� Bitm

mos

� Flas
seve
Flas
auto
editi
256-

� GIF 
that 
your
outp

� JPE
stren
adva
an im
data
an a
or on

You 
on a
othe
allow
prefe
outp

� PNG
GIF.
the v
deco
outp

by scanners, TIFF files are widely 
t work with photographs and other 

apped graphic (also called a raster 
solution. TIFF image files can be used 

F compressed files for images are 
 files.

X file format is for images used in 
s PC Paintbrush and Paint.

he Microsoft Windows Metafile file 
 (vector) images in Windows programs. 
es using the Black & White Scalable 

rmats 

ful for text and graphics that will be 
 Web. When this format is selected for a 
 both text and images, the text is 
nd is saved as HTML, and the graphics 
 files.

t useful for text, photos, and drawings. 
r to view .pdf files. If no changes need to 
 type is useful for sharing (as through 
of its generally small file size.

at can be used with a page that 
tures. The formatting of text in an .rtf file 

d then interpreted by other programs.

at for saving only the text in the 
ou are using the Editable Text (OCR) 
itable, unformatted, ASCII text.
to TOC Scanning fr

e types
ile formats 

ap (.bmp). Often a good choice because Windows itself and 
t Windows programs accept the .bmp file type.

hPix (.fpx). A FlashPix file contains a complete image plus 
ral lower resolution copies of that image. The advantage of the 
hPix file format over other file formats is that a program can 
matically select the best resolution for a particular job to make 
ng and using images faster and easier. Cannot be used with 
color output types.

(.gif). GIF is a compressed file format suitable for an image 
will be used on the Web or on multiple platforms. You can save 
 GIF file as an interlaced GIF. Cannot be used with True Color 
ut type.

G (.jpg). JPEG is a compressed file format for images. Its 
gths are small file sizes and speed. The trade-off for these 
ntages, though, is reduced image quality. Because each time 
age is compressed with JPEG it loses a little of the image 

, avoid compressing a file with JPEG more than once. JPEG is 
ppropriate file format for an image that will be used on the Web 
 multiple platforms.

can save your JPEG file as a progressive JPEG. When used 
 Web page, a progressive JPEG is initially sent as just every 
r line, with the remaining lines sent immediately after. This 
s a (somewhat blurry) image to display sooner. Most people 
r this. JPEG can be used only with True Color and Grayscale 

ut types.

 (.png). A compressed image file format that might replace 
 Like GIF, PNG uses non-lossy compression, which means all 
isual data is saved and restored when the file is 
mpressed. Unlike GIF, PNG can be used with the True Color 
ut type, as well as grayscale ones.

� TIFF (.tif). Usually created 
accepted by programs tha
images. A TIFF file is a bitm
graphic) and can be any re
on multiple platforms.

� TIFF compressed (.tif). TIF
smaller than standard TIFF

� PCX image (.pcx). The PC
Windows programs such a

� Windows Metafile (.wmf). T
format is used for scalable
It is only available for imag
(vector) output type.

Text or text-and-image file fo
� HTML (.htm). HTML is use

viewed on the World Wide
scanned image containing
converted to editable text a
are saved as GIF or JPEG

� PDF (.pdf). PDF is a forma
Use Adobe Acrobat Reade
be made to the file, this file
e-mail) and filing because 

� Rich Text (.rtf). The .rtf form
contains text or text and pic
can usually be retained an

� Text (.txt). Use .txt file form
selection area and when y
output type. Text will be ed
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Prin

The se
selecti
blank a
The Pr
selecte
Bitma
Printin
image

To prin
1 Do

�

�

2 In 

 website

e by scanning directly to the Web. 
 photos and other items by visiting your 
dress you can give them.

k Scan To.
uided Steps (if visible), click .
rom the list and click Scan.
he screen to finish posting the scanned 

 a scan on a site other than an 
ebsite, save the scanned image 
ace the file on the site as you 
Scanning from HP Precisionscan Pro

ting

lection area is the part of the image that prints. If there is no 
on border, the contents of the entire scanner bed, including 
reas, print. 
int command is disabled if one of these output types is 
d: Editable Text (OCR), Text and Image, or Black and White 

p Scalable. To print, you must select a different output type.
g does not save the image to the computer. Save the scanned 
 to a file to use the image later.

t
 one of the following:
On the Scan menu, click Print.
On the toolbar, or the Guided Steps (if visible), click .
the Print dialog box, select the options you want and click OK.

Placing a scan on a

Share photos with other peopl
People you know can view the
website, which will have an ad

To place a scan on a website
1 Do one of the following:

� On the Scan menu, clic
� On the toolbar, or the G

2 Select HP Share-to-Web f
3 Follow the instructions on t

image to the website.

Tip If you want to place
HP Share-to-Web w
as a file and then pl
normally do.
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Settin

When yo
and use
Right-cli
To chan
and click

Copy

You can
into a fil
become

To copy
1 In th

� O
� O

2 In th
inse

3 Cho

ping into another 

ned image into another program if that 
op. The cursor turns to a  if you try to 
rogram that does not support drag-and-
over a program or area that does not 

r program
n program. Make sure you can see both 
d the HP Precisionscan Pro software.
ro software, place the cursor over the 

rea and drag to the location in the 
, release the mouse button. Wait for the 
scan of the image.
to TOC Scanning fr

g the scanned image as wallpaper

u choose this command, the software performs the final scan 
s the results as the wallpaper on your Windows Desktop. 
ck on the scanned image and click Set as Wallpaper.
ge to a different wallpaper, right-click on the Windows Desktop 
 Properties.

ing and pasting into another program

 copy the scanned image to the Clipboard and then paste it 
e in the destination program. After the image is pasted, it 
s a part of the file.

 and paste into another program
e HP Precisionscan Pro software, do one of the following:
n the Edit menu, click Copy.
n the toolbar, click .
e destination program, place the cursor where you want to 
rt the scanned image and click. 
ose the Paste command in the program.

Dragging-and-drop
program

You can drag-and-drop a scan
program supports drag-and-dr
drop a scanned image into a p
drop, or if you drag the image 
support drag-and-drop.

To drag-and-drop into anothe
1 Open a file in the destinatio

the destination program an
2 In the HP Precisionscan P

scanned image.
3 Click inside the selection a

destination program. Then
scanner to perform a final 
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Drag
Desk

Scann
folder 
given a
scanne
Theref
drag-a

To dra
1 Ma

an
2 In 

sca
3 Pre
4 Wh

the
sca

uick, convenient way to scan and save 
CD. This feature is a helpful shortcut for 
 or store scans on CDs. To scan to a 
ardware installed and have a rewritable 

e any adjustments you want in using the 

ro software, do one of the following:
k Scan to CD.On the toolbar, click  

lled, this drive is automatically listed at 
 have created folders on your CD to 
e desired folder in which to save the 

elect the file type. To change the file 
type in the drop-down list.
Scanning from HP Precisionscan Pro

ging-and-dropping to the Windows 
top or a folder 

ed images you drag-and-drop to the Windows Desktop or a 
in Windows Explorer become a bitmap file. The bitmap file is 
 generic name such as �scan.bmp.� Subsequent images 
d to the Desktop or that folder replace the current one. 

ore, if you want to save a scanned image, rename it before you 
nd-drop another image to that location.

g-and-drop to the Windows Desktop or a folder
ke sure you can see both the HP Precisionscan Pro software 
d the Desktop or the folder you want in Windows Explorer.
the HP Precisionscan Pro software, place the cursor over the 
nned image.
ss CTRL and click over the selection area.
ile holding down the mouse button, drag the scanned image to 
 Desktop or folder and release the mouse button. Wait until the 
nner performs the final scan.

Scanning to CD

The Scan to CD function is a q
scanned items to a rewritable 
people who frequently archive
CD, you must have CD-writer h
CD available.

To scan to CD
1 Start a new scan, and mak

scanning software.
2 In the HP Precisionscan P

� On the Scan menu, clic
(Scan to CD).

A Save As dialog appears.
3 If a CD-writer drive is insta

the top of the dialog. If you
organize images, select th
scan.

4 Type in a file name.
5 In the Save As Type list, s

type, select a different file 
6 Click Save.



Back om HP Precisionscan Pro 67

Othe

In this s

� Whic
best

� How
whe

� How
item

� How
"Sca

� How
"Sca

� How
OCR

 quality

e, and values for other controls 
le size.
e scanner chooses the defaults for 
 you do not need to change them. If you 

 or want help choosing a file type, see:

n page 43.

age 46.

63.

n output type, view the Guided 
t already displayed, click . In 

t the output type is what you 
e Choose from the drop-down 

will be printed, choose TIFF 
 file type to reduce the file size 
uality. Also, many different 
 this file type.
to TOC Scanning fr

r features and tips

ection, you can find information about:

h settings to use to get the best image quality. (See "Tips for 
 image quality" on page 67.)

 to save a group of settings and use them with future scans 
n you select them. (See "Saving settings" on page 68.)

 to change the default settings the scanner uses to scan all 
s. (See "Setting preferences" on page 68.)

 to start scanning from programs compliant with TWAIN. (See 
nning from other programs (TWAIN)" on page 71.)

 to scan using Windows Imaging Application (WIA). (See 
nning from other programs (WIA)" on page 72.)

 to make scanned text editable. (See "What to expect from 
 programs" on page 73.)

Tips for best image

Output type, resolution, file typ
determine image quality and fi
When you first scan an item, th
output type and resolution, and
want to change these settings

� "To select an output type" o

� "Changing resolution" on p

� "List of file types" on page

Tip For help choosing a
Steps. If they are no
step 3 �Confirm tha
want,� select Help M
list.

Tip For any image that 
compressed as the
while maintaining q
programs recognize
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Savi

You ca
a parti
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the se
you alw
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Saved
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preser

To sav
1 Ma

in 
the

2 On
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3 In 
an

To use
1 Sc
2 On
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lt settings for all scans performed. To 
m currently being scanned see "Making 

n page 45 and "Making optional 
ge 49.

references.

ant. See the next sections for 
tabs.
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ng settings 

n save and name a group of settings that you frequently use for 
cular purpose and apply them to items you scan in the future. 
ample, if you routinely e-mail pictures to someone, you can save 
ttings including the output type, resolution, and dimensions that 

ays use. The settings are automatically applied when you scan 
re and choose the group of settings.
 settings override the default settings and any changes you 
up to that point. Any changes you make after that point are 
ved.

e settings
ke sure the scanned image whose settings you want to save is 

the preview window and that you have adjusted any settings for 
 image.
 the Scan menu, point to Settings, and click Save. The settings 
 the current scanned image appear.
the drop-down list at the bottom, type a name for these settings 
d click Save.

 settings
an an item to the HP Precisionscan Pro software.
 the Scan menu, point to Settings, and click Load. 
lect the group of settings you want from the list at the bottom 
d click Load.

Setting preferences

The preferences are the defau
change a setting only for the ite
optional adjustments, basic" o
adjustments, advanced" on pa

To set scanning preferences
1 On the Scan menu, click P
2 Click the tab you want.
3 Change any settings you w

descriptions of options on 
4 When finished, click OK.
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Scanner
The Sca
options.
Preview
When se
Scan To
the scan
Precisio
Best Qu
When se
When cl
faster.
Best Qu
When se
scan. W
scannin
Maximu
When se
to produ
process
Noise R
When se
When cl
Enable 
When se
you if th
scanner
.rtf, and 

eps the scanner lamp and the XPA light 
d on beyond the default time out. This 

benefits: 
y eliminating the lamp warm up that is 

en scans
rce on beyond the default time out so 
 table for viewing 35 mm slides

p and the XPA light source (if 
ff after a period of inactivity. 
to TOC Scanning fr

 tab options 
nner tab of the Preferences dialog box controls these 

 scan when the Scan To button is pushed
lected, a preview of the scan appears when you press the 

 button on the scanner. When cleared, the software starts, but 
ner does not scan. You will start a scan from the HP 
nscan Pro software.
ality Scaling
lected, the highest quality scaling is applied to the final scan. 

eared, normal quality scaling is applied, making scanning 

ality Sharpening
lected, the highest quality sharpening is applied to the final 

hen cleared, normal quality sharpening is applied, making 
g faster.
m Pixel Depth 
lected, the largest pixel bit depth is acquired from the scanner 

ce the highest quality image. When cleared, less image data is 
ed, making scanning faster.
eduction
lected, reduces the noise in the image caused by the scanner. 

eared, noise reduction is not applied, making scanning faster.
Scan Another Page Dialog 
lected, a dialog box appears during final scanning that asks 

ere are more pages of this item to scan. When cleared, the 
 assumes each job is only one page. Applies only to .pdf, .txt, 
.html formats.

Extend lamp time out 
When selected, this setting ke
source (if it is connected) turne
feature provides the following 

� reduces scanning time b
typically required betwe

� keeps the XPA light sou
you can use it as a light

When cleared, the scanner lam
connected) time out and turn o
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Selecti
The Se
Autom
When 
which 
Autom
When 
of the 
Autom
When 
values
the op
for an 
Adjus
open.W
reset t
Autom
When 
values
create
differe
When 
contro

e default resolution values available 
olution on the Tools menu. 
, but you can add custom resolution 
esolutions that do not appear here, 200 
he Change Resolution dialog box. 
d because they are the recommended 
d white images.
 999,999. Click Add to add a value. Or, 
 to delete that value. 

es dialog box controls the following 
put from the optical character 

xt from the page into frames and 
ge formatting as closely as possible to 
to which the text is placed must support 

lumn and other formatting and inserts 
losely as possible to where they were in 
easier to edit.

age the OCR program uses to check 
m.
Scanning from HP Precisionscan Pro

on Area tab options
lection Area tab controls the following preferences.
atically create selection area after a mouse click 

selected, a selection area will be created around an area on 
you click with the cursor. 
atically set the Output Type after selection 

selected, the software automatically determines the output type 
area inside the selection border.
atically adjust exposure after selection 

selected, the scanning software automatically changes the 
 in the Adjust Exposure or Adjust Black and White dialogs to 
timal values each time you create a new selection area. Values 
image do not change if you adjust the selection area while the 
t Exposure or Adjust Black and White dialog box is 

hen cleared, the scanning software does not automatically 
he controls in these two tools.
atically adjust color after selection 

selected, the scanning software automatically changes the 
 in the Adjust Color dialog to the optimal values each time you 
 a new selection area. Values never change if you create a 
nt selection area while the Adjust Color dialog box is open.
cleared, the scanning software does not automatically reset the 
ls.

Resolution tab options 
The Resolution tab controls th
when you select Change Res
Default values are already set
values or delete values. Two r
dpi and 300 dpi, do appear in t
These values cannot be delete
values for photos and black an
The range of resolution is 12 to
select a value and click Delete

Text tab options 
The Text tab of the Preferenc
preferences related to text out
recognition (OCR) program.
Text Output (format) 
� Framed text places the te

attempts to recreate the pa
the original. The program in
this type of option.

� Flowed text eliminates co
any images in the text as c
the original. Flowed text is 

Current OCR Language 
Allows you to choose the langu
words it is processing in the ite



Back om HP Precisionscan Pro 71

Controls
The Con
range re
The con
available
Black &
range re
threshol
Choose

� 8-bi
reso

� 10-b
reso

� 12-b
reso

� 16-b
reso

r programs (TWAIN)

y into an open file in one of your 
AIN-compliant. Generally, the program 
d such as �Acquire,� �Scan,� or �Import 
 if the program is compliant or you do 

s called, see the documentation for the 

WAIN-compliant program, the HP 
y start if the TWAIN-program allows it. If 

ware starts, you can make changes to 
uld. If not, the image returns to the 

ot TWAIN-compliant, you can try 
r drag-and-drop the image into 
ve the image as a file and then 
program.
to TOC Scanning fr

 tab options
trols tab of the Preferences dialog box controls the control 
adout to use for scanning.
trol range sets the amount of tonal resolution per color 
 for correction in the Adjust Exposure command and Adjust 

 White command. Using a larger number of bits for the control 
sults in greater control of compensation for exposure or 
d correction.
 one of these options:

t readout (0-255) � sets the controls to use 8 bits of tonal 
lution per color

it readout (0-1023) � sets the controls to use 10 bits of tonal 
lution per color

it readout (0-4095) � sets the controls to use 12 bits of tonal 
lution per color

it readout (0-65535) � sets the controls to use 16 bits of tonal 
lution per color

Scanning from othe

You can bring an image directl
programs if the program is TW
is compliant if it has a comman
New Object.� If you are unsure
not know what the command i
program.
When scanning from within a T
Precisionscan Pro software ma
the HP Precisionscan Pro soft
the image as you normally wo
TWAIN-program immediately.

Tip If your program is n
to copy and paste o
the program. Or, sa
place the file in the 
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The im
the im
If the i
accept
using 

r programs (WIA) 

ws Imaging Application (WIA) is another 
into an application in which you are 
rd. With WIA, you are using Microsoft 

ompliant if it has a command such as 
era on the Insert or the File menu. If 

ogram is compliant or you do not know 
led, see the documentation for the WIA 

(WIA)
to Picture and then click From Scanner 

 scanner or camera connected, select 
e under Device.
 for your scan. Click Web Quality if you 
your picture can be viewed on the 
 if you want a higher resolution for 

ture and place it into the document 

documentation for the WIA-compliant 
Scanning from HP Precisionscan Pro

n from other programs (TWAIN)
rt a scan from within the other program by choosing the 
quire (or similar) command. 
he HP Precisionscan Pro software opens and displays the 
view image, create a selection area. You can crop the scan (if 

cessary), select the output type, and make optional adjustments 
 you normally would. See the appropriate sections in this chapter 
 instructions.
en finished making changes to the scanned image, do one of 
 following to perform a final scan and place it in the program 
m which you started scanning:
On the Scan menu, click Return Image to. 
Click .
age appears in the open program. You might have to reposition 

age. 
mage does not appear, the TWAIN-compliant program might not 
 the resolution or output type you selected. Rescan the image 
the default settings the software sets for the image.

Scanning from othe

(For Windows Me only) Windo
way to scan an image directly 
working, such as Microsoft Wo
software to scan.
Generally, a program is WIA-c
Picture/From Scanner or Cam
you are unsure whether the pr
what the scan command is cal
program.

To scan from other programs 
1 On the Insert menu, point 

or Camera.
2 If you have more than one

the scanner you want to us
3 Select the quality you want

want a lower resolution so 
screen. Click Print Quality
printing the picture.

4 Click Insert to scan the pic
using predefined settings.

For more information, see the 
program.
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� crisp
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These ty

� text 

� text 

� lette
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� text 

Handwr
to TOC Scanning fr

 to expect from OCR programs 

haracter recognition programs convert some text more 
ly than other text. Because OCR technology is never perfect, 
d all converted text carefully to ensure the characters have 
rrectly interpreted.
pes of text convert most accurately:

in standard fonts

in 9-point font or larger

, clear text

k text on a white background

pes of text might convert less accurately:

close to non-text elements, such as bullets, lines, or graphics

in spreadsheets, tables, or forms

rs that have gaps, that �bleed� along their edges, or that touch 
r letters

rlined text 

on colored paper

iting cannot be converted.
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Using accessories

anners support using the HP Scanjet Automatic Document 
(ADF) and the HP Scanjet Transparency Adapter (XPA) for 
g slides and negatives. (Some models only, see the "Front 
d accessories comparisons" on page 3.)
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You ca
When 
softwa
ADF, s
prepar

To sca
1 Pla

fac

 center the stack.

an Pro software and follow the 
ter screen.
nt of the scanner.
e HP Precisionscan Pro software or 
an Pro software using the Scan To 

ox opens and displays the current 
 and page size, which you can change. 
Settings and choose settings you have 

le, click Scan. Or, to scan directly to a 
 To, select a destination, and click Scan.
ny scanner button except the Scan To 
s on the screen to complete the scan.
Using accessories

nning from the ADF

n scan multiple-page items quickly and easily using the ADF. 
you use the ADF, you can scan to the HP Precisionscan Pro 
re or other destinations. For instructions about setting up the 
ee the Setup and Support Guide. For information about 
ing items for the ADF, see "Items for the ADF" on page 16.

n from the ADF
ce a stack of similarly sized originals in the document input tray, 
e up with the first page on top.

2 Adjust the paper guides to

3 Do one of the following:
� Start the HP Precisionsc

directions on the compu
� Press a button on the fro
If you start the scan from th
scan to the HP Precisionsc
button ( ):
 a The ADF Scan dialog b

output type, resolution,
Or, you can click Load 
preset.

 b To scan the item to a fi
destination, click Scan

If you start the scan from a
button, follow the direction
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Scan

You can

See the
XPA. 
See "Ite
items fo

s, use the XPA light source and the 
ing fewer than three slides, you also 

onnected to its port on the scanner, 

 on the scanner glass so the arrow is in 
r. Push the positioning plate toward the 

Tip
to TOC

ning from the XPA

 scan 35 mm slides or negatives using the XPA. 

 Setup and Support Guide for information about installing the 

ms for the XPA" on page 16 for information about preparing 
r the XPA.

Scanning slides 

To scan standard 35 mm slide
positioning plate. When scann
need the slide light shield.

To scan slides
1 With the XPA light source c

restart the software. 
2 Place the positioning plate

the upper right-hand corne
top right corner.

Do not use the XPA to scan a letter-size item, such 
as a presentation transparency. Place the 
transparent item on the scanner glass, place a white 
piece of paper on top, and scan as you normally 
would using the Scanner Glass command on the 
Scan menu.
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3 Sli
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4 If y
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n Pro software, click the Scan menu, 

s, see "Making optional adjustments for 
e 81.
ing the XPA light source, on the Scan 
. Disconnect the XPA light source if you 

Tip
Using accessories

de up to three slides into the slide holder on the bottom side of 
 XPA light source. Slides should be right-side facing you.

ou are scanning fewer than three slides, insert the slide light 
ield after you load your last slide.
ce the XPA light source into the positioning plate with slides 
ing down and the HP logo facing you.

6 From the HP Precisionsca
and select XPA (Slides).

7 Before making any change
slides or negatives" on pag

8 When you have finished us
menu, click Scanner Glass
want.

The XPA light source also functions as a light table 
for viewing 35 mm slides. Insert slides as shown 
above.
To keep the XPA light source on beyond the default 
period, select the Extend lamp time out setting in 
the HP Precisionscan Pro software. See "Setting 
preferences" on page 68. 

HP logo here
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Scann

To scan
plate, an
negative

To scan
1 With

resta
2 Plac

the u
top r

 into the negative holder. If the negative 
uld be facing out toward you.
re easily damaged. Touch them only on 

f negatives with fewer than four frames, 
eld after the negative strip. See the icon 
assistance.
to the slide holder on the bottom side of 
to TOC

ing negatives 

 35 mm negatives, use the XPA light source, the positioning 
d the negative holder. When scanning fewer than four 
 frames, you also need the negative light shield.

 negatives
 the XPA light source connected to its port on the scanner, 
rt the software. 
e the positioning plate on the scanner glass so the arrow is in 
pper right-hand corner. Push the positioning plate toward the 
ight corner.

3 Slide the strip of negatives
strip curves, the curve sho
CAUTION Negatives a

the edges.

4 If you are scanning a strip o
insert the negative light shi
on the negative holder for 

5 Slide the negative holder in
the XPA light source.
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ce the XPA light source into the positioning plate with negatives 
ing down and the HP logo facing you.

m the HP Precisionscan Pro software, click the Scan menu, 
d select XPA (Negatives).
fore making changes, see "Making optional adjustments for 
es or negatives" on page 81.
en finished using the XPA light source, on the Scan menu, click 

anner Glass. Disconnect the XPA light source if you want.

HP logo here
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using th
selection
correctly
page 42
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selection
the follo

� Midt
page

� High
page

� Sha
page

� RGB
colo

 for slides or negatives

tness or darkness of the scanned image 
 range for the number in the Midtone 

overall
lick Adjust Exposure.

to the right.
 the Midtone field and press ENTER.

overall
lick Adjust Exposure.

to the left.
the Midtone field and press ENTER.

s
lick Adjust Exposure.
dtone, highlight, and shadow settings to 
r negative.

Tip

Tip
to TOC

ing optional adjustments for 
s or negatives

 make optional adjustments to slides or negatives scanned 
e XPA. Before deciding to make adjustments, create a 
 area around one slide or negative so the software exposes it 
. See "Cropping or selecting an area for final scan" on 
.
oose to make adjustments to the image after you create a 
 area, make most of them as you normally would, except for 

wing adjustments:

one. See "Adjusting midtones for slides or negatives" on 
81.

light. See "Adjusting highlights for slides or negatives" on 
82.

dow. See "Adjusting shadows for slides or negatives" on 
82.

 values and pixel color. See "Viewing RGB values and pixel 
r" on page 83.

Adjusting midtones

You can adjust the overall ligh
using the midtone setting. The
field is -100 to 100.

To lighten slides or negatives 
1 On the Advanced menu, c
2 Do one of the following:

� Drag the Midtone slider 
� Type a higher number in

To darken slides or negatives 
1 On the Advanced menu, c
2 Do one of the following:

� Drag the Midtone slider 
� Type a lower number in 

To return to the default setting
1 On the Advanced menu, c
2 Click Auto to return the mi

the defaults for this slide o
See "Making optional adjustments, basic" on 
page 45 and "Making optional adjustments, 
advanced" on page 49 to make all adjustments 
except the ones mentioned above.

To enlarge a slide or negative, see "Resizing 
(output dimensions)" on page 45.
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Adju

You ca
range 

To ligh
1 On
2 Do

�

�

To dar
1 On
2 Do

�

�

To retu
1 On
2 Cli

the

 for slides or negatives

ten or darken the dark areas. The range 
s field is -100 to 100.

lick Adjust Exposure.

to the right.
 the Shadows field and press ENTER.

lick Adjust Exposure.

to the left.
the Shadows field and press ENTER.

s
lick Adjust Exposure.
dtone, highlight, and shadow settings to 
r negative.
Using accessories

sting highlights for slides or negatives

n adjust highlights to lighten or darken the light areas. The 
for the number in the Highlights field is -100 to 100.

ten lighter areas
 the Advanced menu, click Adjust Exposure.
 one of the following:
Drag the Highlight slider to the right.
Type a higher number in the Highlights field and press ENTER.

ken lighter areas
 the Advanced menu, click Adjust Exposure.
 one of the following:
Drag the Highlight slider to the left.
Type a lower number in the Highlights field and press ENTER.

rn to the default settings
 the Advanced menu, click Adjust Exposure.
ck Auto to return the midtone, highlight, and shadow settings to 
 defaults for this slide or negative.

Adjusting shadows

You can adjust shadows to ligh
for the number in the Shadow

To lighten darker areas
1 On the Advanced menu, c
2 Do one of the following:

� Drag the Shadow slider 
� Type a higher number in

To darken darker areas
1 On the Advanced menu, c
2 Do one of the following:

� Drag the Shadow slider 
� Type a lower number in 

To return to the default setting
1 On the Advanced menu, c
2 Click Auto to return the mi

the defaults for this slide o
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View

You can
color or 

To view 
1 On t
2 Click
3 Mov

the v
the h

4 Whe
to TOC

ing RGB values and pixel color

 view the RGB values and pixel color for any spot in an image, 
grayscale, using the RGB Meter.

RGB values and pixel color
he Advanced menu, click Adjust Exposure.
 . The cursor changes to an eyedropper.

e the cursor over the area in the item for which you want to see 
alues. The values appear in the RGB area. A line appears in 
istogram to show you where those pixels occur.
n finished, click  again.
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lways perform these actions first.

 is securely connected between the 
l outlet or surge protector.

cted to a surge protector, make sure the 
into an outlet and turned on.

ble is securely connected between the 

nlocked. Move the lock to the unlocked 
ly, see "Front panel and accessories 

e from the scanner and turn off the 
s, reconnect the power cable to the 
he computer, in that order.

ose it. Press CTRL+ALT+DELETE to open 
anager. Select any program listed as 
End Task.

he issue, see "Starting troubleshooting" 
to TOC

Troubleshooting and maintaining

tion provides information for:

ing issues that might occur while using the scanner or 
canning software, or issues with the appearance of scanned 
es. Start with "Checking the basics" on page 85. 

ring jams from the ADF. See "Clearing jams from the ADF" on 
102.

ning and maintaining the scanner and accessories. See 
aning and maintaining" on page 105.

 Setup and Support Guide for installation and troubleshooting 
ion.

Checking the b

If the scanner is not working, a

� Check that the power cable
scanner and a live electrica

� If the power cable is conne
surge protector is plugged 

� Check that the interface ca
scanner and the computer.

� Make sure the scanner is u
position. (Some models on
comparisons" on page 3.) 

� Disconnect the power cabl
computer. After 30 second
scanner and then turn on t

� If a program has frozen, cl
Close Programs or Task M
Not Responding and click 

If these steps did not resolve t
on page 86.
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Start h
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�

�

The qu
�

�

�

�

Scans 
Se

 HP Scanjet Transparency Adapter 
atic Document Feeder (ADF).

e ADF. See "Clearing jams from the 

e ADF, other than pages jamming. See 
he ADF" on page 101.
e XPA. See "Resolving issues with the 
Troubleshooting and maintaining

rting troubleshooting

ere to find the information you need. Choose one of these 
l groups of issues, and then choose one of that group�s more 

c issues.

anner or software is not working.
A message is on the scanner or the computer. Follow the 
directions in the message to resolve the issue.
There is no message. See "Resolving issues that did not 
generate messages" on page 87.
There is an error message on the front panel liquid crystal 
display (LCD). See "Resolving scanner messages" on page 87.

ality of resulting scans is not what I expected.
Scanned images do not look good. See "Resolving issues with 
scanned images" on page 91.
Printed copies do not look good. See "Resolving issues with 
printed copies" on page 93.
Text on images is not editable. See "Resolving issues with 
editable text" on page 96.
Slides or negatives do not look good. See "Resolving issues 
with slides and negatives" on page 95.

are not arriving at the destination I choose.
e "Resolving issues sending to destinations" on page 97.

I am having an issue with the
(XPA) or the HP Scanjet Autom

� Pages are jammed in th
ADF" on page 102.

� There is an issue with th
"Resolving issues with t

� There is an issue with th
XPA" on page 100.



Back shooting and maintaining 87

Reso

(Some m
on page
panel LC
this sect

ADF Pap
Pag
on p
Clea
the s

Error ##
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See

Scanner
(Som
com
lock
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s that did not 
ages

t working but no message appears, look 
is section.

are no longer on the computer.
not have been saved as a file. If you 
 destination, the scanned image is not 

hen you use HP Precisionscan Pro to 
 the image to your computer.

ime out and turn off automatically after a 

d the scanner, wait a few more minutes. 
ill on, you might have activated the 
eature. Check this setting on the 
erences of the HP Precisionscan Pro 
references" on page 68.
utton on the front panel of the scanner 
e scanner lamp and the XPA light 

ee "General tab options" on page 37.
ms with the scanner lamp or the Power 
ustomer Support. (See �Contacting HP 
etup and Support Guide.) 
to TOC Trouble

lving scanner messages

odels only, see "Front panel and accessories comparisons" 
3.) If an error message appears on the 16-character front 
D display on your scanner, look for the cause and solution in 

ion.

er Jam
es are jammed in the ADF. See "Clearing jams from the ADF" 
age 102 for information on clearing paper jams from the ADF.
r the paper jam. If the error message does not clear, unplug 
canner and plug it back in.

scanner reported an error during the self-test.
lug the scanner and plug it back in. If this error message is still 
e scanner, contact HP support. Visit the HP support website 

://www.hp.com/go/support
 the Setup and Support Guide for phone contact information.

 Locked
e models only, see the "Front panel and accessories 

parisons" on page 3.) The scanner is not working because it is 
ed. Make sure the scanner is unlocked. Move the lock to the 
cked position. If the error message does not clear, unplug the 
ner and plug it back in.

Resolving issue
generate mess

If the scanner or software is no
for the cause and solution in th

Items you scanned previously 
The scanned image might 
send an image directly to a
saved on the computer. W
scan, use Save As to save

The scanner lamp stays on.
The scanner lamp should t
period of inactivity. 
� If you have recently use
� If the scanner lamp is st

Extend lamp time out f
Scanner tab in the Pref
software. See "Setting p

� Press the Power Save b
to immediately turn off th
source (if connected). S

If you still encounter proble
Save button, contact HP C
Customer Support� in the S

http://www.hp.com/go/support
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scanner, the incorrect program opens.
open when you press the button on the 

 Settings, and click Control Panel.
d Cameras. Select your scanner model 
not already selected.

 list, select the name of the button you 
function is set for this button.

 Settings, and click Control Panel.
d Cameras. Double-click the icon next 
ng device.

 list, select the name of the button you 
function is set for this button.
ows 95:
 Programs, point to HP Scanjet 

njet Button Manager.

 list, select the name of the button you 
function is set for this button.
Troubleshooting and maintaining

 a scanned image to a file, but now I cannot open the file in 
gram I want.

u might have saved the file in a format the other program cannot 
e. Save the file in a different format the program can use. Look in 
 File Open or Import command for the program to see which 
 types it supports.

anner is not working.
e or more of these issues might be causing the problem:
The scanner was not installed properly.
The interface cable is not compatible with the scanner.
A cable might be loose. Check that the interface cable is 
securely connected.
If the scanner is emitting a grinding sound, the scanner is 
locked.
e "Checking the basics" on page 85, and the Setup and Support 
ide for installation and troubleshooting information.

anner does not scan right away.
he scanner has not been used for a while, the scanner lamp has 
ned itself off. The lamp goes through a warm-up period after you 
rt the software, or press the Scan To button. Wait for a few 
conds for scanning to begin.

When I press a button on the 
Check which function is set to 
scanner:
In Windows 98 and 2000:
1 On the Start menu, point to
2 Double-click Scanners an

number from the list if it is 
3 Click Properties.
4 From the Scanner Events

want to check. Verify what 
In Windows Me:
1 On the Start menu, point to
2 Double-click Scanners an

to the name of your scanni
3 Click Properties.
4 From the Scanner Events

want to check. Verify what 
In Windows NT 4.0 and Wind
1 On the Start menu, point to

Utilities, and click HP Sca
2 Click the Events tab.
3 From the Scanner Events

want to check. Verify what 



Back shooting and maintaining 89

When I 
in the so

� A
se

� Yo
C
H
pa

� (S
co
so
bu

In Wind
1 On t
2 Dou

num
3 Click
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6 Mak
In Wind
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to th
3 Click
4 From
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next
6 Verif

ows 95:
o Programs, point to HP Scanjet 
njet Button Manager.

 list, select the Scan To button.
nscan Pro check box is checked.

ents check box is unchecked.

y slowly.
it text, the optical character recognition 

the scanner to scan more slowly, which 
em to scan.
n cause the scanner to scan more 
s. See "Setting preferences" on 

 set too high. Return to the default 
ng resolution" on page 46.

t appear in the HP Precisionscan Pro 

 then disconnected it, restart the 

A, on the Scan menu, click Scanner 
glass again. 
he XPA and the XPA (Slides) or XPA 
 are unavailable, restart the software 
ce is connected to the scanner.
to TOC Trouble

choose Scan To on the scanner, the image does not appear 
ftware.

 cable might be loose. Check that the interface cable is 
curely connected.
u might have accidentally turned off the preview feature. 

heck this setting on the Scanner tab in the Preferences of the 
P Precisionscan Pro software. See "Setting preferences" on 
ge 68.
ome models only, see the "Front panel and accessories 
mparisons" on page 3.) Check that the HP Precisionscan 
ftware is the program set to start when you press the Scan To 
tton ( ) using the following steps.

ows 98 and 2000:
he Start menu, point to Settings, and click Control Panel.
ble-click Scanners and Cameras. Select your scanner model 
ber from the list if it is not already selected.
 Properties.
 the Scanner Events list, select the Scan To button.

e sure the HP Precisionscan Pro check box is checked.
e sure the Disable Device Events check box is unchecked.
ows Me:
he Start menu, point to Settings, and click Control Panel.
ble-click Scanners and Cameras. Double-click the icon next 
e name of your scanning device.
 Properties.
 the Scanner Events list, select the Scan To button.

er Actions, make sure that HP Precisionscan Pro is selected 
 to Start This Program.
y that the Take No Action check box is unchecked.

In Windows NT 4.0 and Wind
1 On the Start menu, point t

Utilities, and click HP Sca
2 Click the Events tab.
3 From the Scanner Events
4 Make sure the HP Precisio
5 Make sure the Disable Ev

Scanner is scanning items ver
� If you are scanning to ed

(OCR) program causes 
is normal. Wait for the it

� Some default settings ca
slowly. Check the setting
page 68.

� The resolution might be
resolution. See "Changi

The correct menu items do no
software.

� If you used the ADF and
software.

� If you were using the XP
Glass to scan from the 

� If you are trying to use t
(Negatives) commands
while the XPA light sour
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on for resolving image-quality issues, 
e scanner glass, the ADF, or the XPA.

nned images" on page 91.

ted copies" on page 93.

es and negatives" on page 95.

 best output type possible, use 
f they are not showing, click .
Troubleshooting and maintaining

anner is making a loud clicking or grinding noise.
e scanner is locked. Move the lock to the unlocked position. 
me models only, see the "Front panel and accessories 

mparisons" on page 3.) 

line Help or the Guided Steps in the HP Precisionscan Pro 
re do not work.
 available for computers running Internet Explorer version 4.0 or 
r. You can install a newer version of Internet Explorer, or you can 
e Online User�s Manual for assistance.

 view the Online User�s Manual:
the HP Precisionscan Pro software, point to the Help menu, and 
k User�s Manual. Or, click the Help button in any dialog box in 
ich it appears.

Resolving imag

This section contains informati
whether you scanned using th

� "Resolving issues with sca

� "Resolving issues with prin

� "Resolving issues with slid

Tip For help getting the
the Guided Steps. I
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Scanned
margins

Ther
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scan

ted lines through them.

t be dirty. Clean the glass. See 
lass" on page 105.
, the ADF glass might be dirty or 
F glass. See "Cleaning the ADF glass" 

ing, or midtone, highlight, and shadow 
e adjusted before scanning. See 
isionscan Pro" on page 39.
 colored paper. If the original was 
er, including brown recycled paper, the 
e clear. Try adjusting the resolution and 
hadow settings from the 

oftware. See "Scanning from HP 
age 39.
to TOC Trouble

ving issues with scanned images

tion contains solutions to issues that affect all scanned 
 regardless of whether you used the scanner glass or the ADF. 
ere printing, see also "Resolving issues with printed copies" on 
.

 images are too light or too dark.

original image might be very light or dark or be printed on 
red paper. Adjust the midtone, highlight, and shadow settings 
 the HP Precisionscan Pro software. See "Scanning from HP 
isionscan Pro" on page 39.

 images have black dots or streaks in top and bottom 
. 

e might be ink, glue, correction fluid, or some other substance 
e scanner glass. Clean the scanner glass. See "Cleaning the 
ner glass" on page 105.

Scanned images have unwan

� The scanner glass migh
"Cleaning the scanner g

� If you are using the ADF
scratched. Clean the AD
on page 106. 

Scanned image is not clear.

� The resolution, sharpen
settings might need to b
"Scanning from HP Prec

� The original might be on
printed on a colored pap
image or text might not b
midtone, highlight, and s
HP Precisionscan Pro s
Precisionscan Pro" on p
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agged, or fuzzy.
 a program other than the 

oftware. Resize the image in the 
oftware before you send it to the other 
 (output dimensions)" on page 45.) Or, 
k and white drawing, use the Black & 
pe for the scanned image. (See 
n page 43.)
 Pro software, the resolution is set too 
 a higher number, or return to the 

anging resolution" on page 46.
 Pro software, too much or too little 
. Adjust the sharpening. See 
on page 48.

 flaws, or scratches, and the scanned 
 HP Precisionscan Pro software.
e manually. Return to the default 

g an image" on page 48.
 is selected. Check the setting. See 
 page 68.

olution in the HP Precisionscan Pro 
y is no better.
 a higher number does not necessarily 
tware sets the resolution automatically 

 you scanned. Keep or return to the 
resolution" on page 46 or "Tips for best 
7 for guidelines.

another program, the program might not 
u set in the HP Precisionscan Pro 

 setting the program uses and set the 
cisionscan Pro software to that 
Troubleshooting and maintaining

age is completely black or completely white.
e item might not be placed correctly on the scanner glass or in 
 ADF. Make sure that the item you are trying to scan is placed 
e down on the glass, or face up in the ADF.

 in the scanned image are different from the original item.
anners, monitors, printers, and different operating systems 
erpret color differently. Use the hue and saturation settings in the 
 Precisionscan Pro software to adjust the colors.

HP Precisionscan Pro software, all of the image scanned when 
wanted part, or vice versa.
e selection area might not be selected correctly. Make sure the 
lection border is surrounding the area you want in the final scan.

ed images are crooked.
e item might have been placed crookedly or shifted when you 
sed the lid. Straighten the original on the scanner glass and 
n again.

ht I made the image smaller or larger before the final scan in 
 Precisionscan Pro software, but it is still the same size as the 
l.

u might have zoomed in or out, which does not change the size 
the image. Change the output size. See "Resizing (output 
ensions)" on page 45.

ginal photo was fuzzy, and the scanned image looks even 

e sharpening level needs to be increased. In the 
Precisionscan Pro software, adjust the sharpening. See 
arpening an image" on page 48.

Scanned images are grainy, j
� You resized the image in

HP Precisionscan Pro s
HP Precisionscan Pro s
program. (See "Resizing
if the original was a blac
White Scalable output ty
"Selecting output type" o

� In the HP Precisionscan
low. Set the resolution to
default setting. See "Ch

� In the HP Precisionscan
sharpening was applied
"Sharpening an image" 

An original photo had marks,
image looks even worse in the

� You sharpened the imag
setting. See "Sharpenin

� Best Quality Sharpening
"Setting preferences" on

I set the image to a higher res
software, but the output qualit

� Setting the resolution to
improve quality. The sof
based on the type of item
default. See "Changing 
image quality" on page 6

� If you sent the image to 
support the resolution yo
software. Determine the
resolution in the HP Pre
resolution.
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e issues with printed pages.

edges are not printing.

p to the edge of the paper. To get the 
able area, you must slightly reduce the 
 Precisionscan Pro software and then 
to TOC Trouble

scanned from the HP Precisionscan Pro software are larger 
 original when viewed or printed from another program, 
MS Paint, MS Internet Explorer, or MS Imaging.
other program did not accept the image size information. Scan 
mage at a lower resolution. When you scan at a resolution the 
ram accepts, it will display or print the image at the correct 
.

ge is too big or too small.
e HP Precisionscan Pro software, set the output dimensions in 
esize dialog box. See "Resizing (output dimensions)" on 
45.

try to scan to the Web from the HP Precisionscan Pro 
, the image is too large or does not look good on screen.
 settings for this image might be set incorrectly. Use the 
ed Steps for help choosing an output type. See also "Tips for 
 image quality" on page 67.

Resolving issues w

Use this section to help resolv

Parts of the page around the 

Printers cannot print right u
image to fit inside the print
size of the image in the HP
reprint the image.
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Copie

�

�

Vertica

�

�

e is blank, or part of a graphic is cut 

plex. (The printer does not have 
s the page.) Set the resolution of the 
the HP Precisionscan Pro software. See 
age 46.

incorrect.
ettings might not be correct. Choose a 
int again. Check the printer settings. If it 
e printer is out of ink or toner. 

r fuzzy.
P Precisionscan Pro software might not 
output type to True Color (16.7 million 
e "Selecting output type" on page 43.
in a file in another program, resized the 
from that program, resizing the image in 
used the issue. Resize in the HP 
are before placing it in a file in another 
 (output dimensions)" on page 45.
 fuzzy and you enlarged it, the fuzziness 
 

Troubleshooting and maintaining

s are too light. 

If you are copying an item printed on colored paper, there might 
not be enough contrast between the ink and paper colors. Adjust 
the highlights, shadows, midtones, and resolution settings from 
the HP Precisionscan Pro software. See "Scanning from HP 
Precisionscan Pro" on page 39. Or, adjust the contrast from the 
HP Scanjet Copy Utility. Also, if possible for text, use originals 
printed with black ink on white paper.
The printer might be out of toner or ink. Print a different file from 
another program to the printer to see if the issue lies with the 
printer.

l white stripes appear on the page. 

The printer might be out of toner or ink. Print a different file from 
another program to the printer to see if the issue lies with the 
printer.
The scanner internal mirror might be contaminated. Contact the 
Customer Service Center for service.

The bottom of the printed pag
off. 

The page might be too com
enough memory to proces
image to 300 dpi or less in 
"Changing resolution" on p

Colors in printed images are 
The output type or printer s
different output type and pr
is a color printer, check if th

Scanned images are jagged o
� The output type in the H

be set correctly. Set the 
colors) or Grayscale. Se

� If you placed the image 
image, and are printing 
the program probably ca
Precisionscan Pro softw
program. See "Resizing

� If the original image was
becomes more obvious.
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negative
HP Prec
negative
XPA" on

I tried to
remaine

You 
the v
size
dime

The colo
� Th

in
th
co

� Th
gl
sc

� If 
su
th
th

� If 
X
re
lig

olored tint, usually pink. 
canned without the XPA, or the 
light source were placed incorrectly on 
teps for scanning 35 mm slides or 
rom the XPA" on page 77.

 box with multi-colored vertical lines or 
w surrounding the area.
t be placed incorrectly on the scanner 
plate on the scanner glass so the 
 the bottom right.

ven though the light on the XPA light 

ght be placed incorrectly on the scanner 
g plate on the scanner glass so the 

 at the bottom right. 
sure command in the Advanced menu.

ed image.
or negative for damage.
, and service may be required.

ource might be broken or not working. If 
 is required.
to TOC Trouble

ving issues with slides and negatives 

 following section to help resolve issues with slides or 
s scanned using the XPA. All actions must be performed in the 
isionscan Pro software, because you must scan slides or 
s using this software. See also "Resolving issues with the 
 page 100.

 enlarge a scanned image of a slide, but the image 
d the same size.
might have used the Zoom In command, which only changes 
iew on the screen. Use the Resize command to change the 

 of the final scanned image. See "Resizing (output 
nsions)" on page 45.

rs are incorrect, or the image is too light or too dark.
e software might be setting exposure for the entire area 

stead of one slide or negative. Create a selection area around 
e slide or negative you want to use to ensure it is exposed 
rrectly.
e positioning plate is not placed completely on the scanner 

ass. Make sure the positioning plate is completely on the 
anner glass.
you are scanning fewer than three slides with the XPA, make 
re to use the slide light shield to cover the remaining area in 
e slide holder. This ensures that no extra light leaks out into 
e scan.
you are scanning fewer than four negative frames with the 
PA, make sure to use the negative light shield to cover the 
maining area in the negative holder. This ensures that no extra 
ht leaks out into the scan.

The scanned image shows a c
The image was probably s
positioning plate and XPA 
the scanner bed. For the s
negatives, see "Scanning f

Scanned images appear as a
as a dashed box with an arro

The positioning plate migh
bed. Place the positioning 
Hewlett-Packard logo is at

The scanned image is black e
source is on.

� The positioning plate mi
bed. Place the positionin
Hewlett-Packard logo is

� Check the Adjust Expo

There are streaks in the scann
� Check the original slide 
� The XPA may be broken

The scans are dark.
The bulb in the XPA light s
the bulb is broken, service
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Res

This se
are try

Scann
If y
ha
Ed
me
pro
as

Scann
So
Ma

Incorre
OCR s

Th
the
be
on
pa

ar in my word-processing program.
recisionscan Pro software, choose 
xt and Image on the Output Type 
menu, click Scan To and choose the 
and paste the text into the program you 
ditable, work with the text as an image 

 text using a different OCR program.

 Precisionscan Pro software, save the 
age file, and open the file in the other 

nscan Pro software. Then, on the Scan 
d choose the other OCR program. 

in font size and style when the text 
ing program.
 cannot always accept the original 
ext. Reformat the text in the word-

e word-processing program without 
 or vice versa.
he formatting and you have the setting 
word-processing program cannot 
g. Reformat text in the word-processing 
Troubleshooting and maintaining

olving issues with editable text

ction contains resolutions to issues that might occur when you 
ing to make text editable.

ed text is not editable.
ou used the HP Precisionscan Pro software, the software might 
ve identified the text as a drawing. In the software, choose 
itable Text (OCR) or Text and Image on the Output Type 
nu. Then, on the Scan menu, click Scan To and choose the 
gram you want. If the text is still not editable, work with the text 

 an image or retype it.

ed text is editable in some programs but not in others.
me programs accept only image formats and do not allow text. 
ke sure the program accepts editable text.

ct characters appear in the text that was converted using the 
oftware.
e accuracy of the OCR program depends on the program having 
 correct settings on the quality of the original item. To obtain the 

st possible results, choose the scan setting for text, and process 
ly crisp, clear text. See "What to expect from OCR programs" on 
ge 73.

Converted text does not appe
If you scanned to the HP P
Editable Text (OCR) or Te
menu. Then, on the Scan 
program you want. Or, cut 
want. If the text is still not e
or retype it.

I do not know how to process
Do one of the following:
� Scan the item to the HP

scanned image as an im
OCR program.

� Scan to the HP Precisio
menu, click Scan To an

The converted text did not reta
was placed in a word-process

Word-processing programs
formatting of the scanned t
processing program.

Converted text appeared in th
its formatting and I wanted it,

Even if you want to retain t
set correctly, the receiving 
always accept the formattin
program.
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After I s
text disp

This
oper
cann
Trad
Euro
lang

s sending to 

es sending images to destinations. Not 
ll scanners.

scanner, scanned images do not 
 e-mail message.

-based or might not be supported. Save 
e and attach it to your e-mail message 

scanner, the scanned image attaches 
xt I want the recipient to be able to 

 recipient, scan the item to the 
ware and change the output type for the 
 Text (OCR). Then, on the Scan menu, 
e e-mail program. Or, save the scanned 
ach it to a message as you normally do.

n on the scanner, the incorrect e-mail 

ram is set to open when you press the 
 the scanner. See "Changing settings for 

ook Express, or Netscape Mail, make 
as your default MAPI application. If you 
cumentation for your e-mail program.
to TOC Trouble

can using Text or Text and Image output type, some of the 
lays as squares or unrecognizable characters.
 is due to the display capability of your Microsoft Windows 
ating system. For example, the English version of Windows 95 
ot properly display Russian, Turkish, Simplified Chinese, 
itional Chinese, Korean, and potentially other non-western 
pean languages. Windows 2000 is able to display all 
uages.

Resolving issue
destinations

Use this section to resolve issu
all functions are available on a

When I choose E-mail on the 
automatically appear in a new

The e-mail program is Web
the scanned image as a fil
as you normally do.

When I choose E-mail on the 
as a bitmap, but it contains te
edit.

To make text editable for a
HP Precisionscan Pro soft
scanned image to Editable
click Scan To and select th
image as a text file and att

When I press the E-mail butto
program opens.

� Check which e-mail prog
E-mail button ( ) on
buttons" on page 34.

� If you use Outlook, Outl
sure the program is set 
are not sure, see the do



98 Back to TOC

When
Utility,

Sc
the

When
at a tim

Ev
job
co

When
comm

If t
Sc
un

When
not ap

�

�

�

n existing file, but the scanned image 
d.
 scanned images to be placed in new 
ge into the file you want. Or, save the 
d import it into the other program.

 image using the Scan To command on 
isionscan Pro software, the program I 

 software might not recognize the 
o one of the following:

e in a file type the other program uses, 
 the other program.
and-drop the image into the other 

at is not being recognized. This might 
can Pro software to recognize it.

nother program, such as my word-
bring an image into my open file, but 

 TWAIN or Windows Imaging 
t. If you cannot find a command such as 
e documentation for the program to see 
ne of the following in the HP 
:
 as a file and then insert the file into the 

Scan menu, and choose a program.
and-drop the image into the other 
Troubleshooting and maintaining

 printing copies from the scanner or the HP Scanjet Copy 
 I cannot choose the printer I want.
an the item to the HP Precisionscan Pro software and print from 
re.

 printing copies, I can only make multiple copies of one page 
e (I cannot collate copy).

en if you are using an ADF, each page is treated as a separate 
. You can make multiple copies of one page, but not multiple 
pies of different pages and collate them.

 I try to print from the HP Precisionscan Pro software, the Print 
and is unavailable.
he Editable Text (OCR), Text and Image, or Black & White 
alable output type is selected, the Print command is 
available. Choose a different output type and then print.

 I choose the Scan To button on the scanner, the image does 
pear in the software.
A cable might be loose. Check that the interface cable is 
securely connected.
You might have accidentally turned off the preview feature. 
Check this setting on the Scanner tab in the Preferences of the 
HP Precisionscan Pro software. See "Setting preferences" on 
page 68.
Check that the HP Precisionscan Pro software is the program 
set to start when you press the Scan To button ( ). See 
"When I choose Scan To on the scanner, the image does not 
appear in the software." on page 89 for steps.

I tried to scan an image into a
appeared in a new file instea

Some programs only allow
files. Cut and paste the ima
scanned image as a file an

When I try to send a scanned
the Scan menu of the HP Prec
want does not appear. 

The HP Precisionscan Pro
program as a destination. D
� Save the scanned imag

and then open the file in
� Copy and paste or drag-

program.
� Reinstall the program th

allow the HP Precisions

I want to start scanning from a
processing program, so I can 
I cannot start the scan. 

The other program must be
Application (WIA)-complian
Acquire or Insert, check th
if it is compliant. If not, do o
Precisionscan Pro software
� Save the scanned image

other program. 
� Click Scan To from the 
� Copy and paste or drag-

program.
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to TOC Trouble

ing to return a scanned image to my TWAIN or WIA-
nt program, but the image will not appear.
TWAIN or WIA-compliant program might not accept the 
lution or output type you selected. Rescan the image using the 
ult settings the HP Precisionscan Pro software sets for the 
e.

 see the destinations I want when I use the Select Destination 
ext to the Scan To button. 
e models only, see the "Front panel and accessories 

parisons" on page 3.)
all destinations appear in the scanner�s destination list. For 

ple, printers, e-mail programs, and saving to a file are not 
ded. The list is also limited to the first 18 destinations found by 
P scanning software. You can access additional destinations 
gh the HP Precisionscan Pro software. See "To send to a 

ram" on page 61 for more information, or do one of the 
wing.
pdate the destinations for your scanner buttons. See "To 
ange settings for buttons or update destinations" on page 34 
r steps.
nplug the scanner and plug it back in.
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Th
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When
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�

�

t scan using the scanner buttons.
 work with the scanner buttons. Use the 

ware when using the XPA.

 light in the transparency adapter after 
(Negatives) in the Scan menu.
ected XPA (Slides) or XPA (Negatives) 
he HP Precisionscan Pro software. If 
e unavailable, restart the software while 
onnected to the scanner.

t source might be broken or not working. 
e connected to the scanner, hold the 
 look for illumination. If the bulb is 
ed.
Troubleshooting and maintaining

olving issues with accessories

ction contains information for resolving issues when you are 
he XPA or ADF.

lving issues with the XPA

ction contains issues that might occur when you are using the 
ransparency adapter). See also "Resolving issues with slides 
gatives" on page 95.

A is not working at all.
e XPA cable might not be connected correctly. Make sure the 
A cable is connected securely to the XPA port on the scanner.

 using the XPA, I cannot choose XPA (Slides) or XPA 
tives) on the Scan menu.
The XPA cable might not be connected correctly. Make sure the 
XPA cable is connected securely to the XPA port on the 
scanner.
If you connected the XPA light source while the HP 
Precisionscan Pro software was running, restart the software. 
Doing so allows the software to detect the XPA.

When using the XPA, I canno
The XPA is not designed to
HP Precisionscan Pro soft

There is no light or only a dim
checking XPA (Slides) or XPA 

� Make sure you have sel
from the Scan menu in t
these two commands ar
the XPA light source is c

� The bulb in the XPA ligh
With the XPA light sourc
XPA light source up and
broken, service is requir
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When u
The 
clos
page

eps jamming.
 the guidelines for the ADF. See "Items 
.
ething on it. Make sure you have 

as staples and self-adhesive notes on 
 and preparing items" on page 15.
e ADF can handle items as small as 

 5.0 inches). Use the glass to scan.
e ADF can handle items as large as 216 
 inches). Use the glass to scan the item 

age is cut off.
ms up to 355.6 mm (14 inches) long. If 
it in sections on the glass. If the item is 
se the correct page size setting in the 
before scanning.
em might be too complex (require too 
rinter to process. If possible, choose a 
ry. Or, select a lower resolution or 
 black and white or grayscale.
to TOC Troubles

ving issues with the ADF

tion contains issues that might occur when you are using the 
ic document feeder (ADF).

 is feeding multiple sheets, skewing pages, or jamming 
ly.
the pages look like they are skewing as they feed into the 
DF, check the resulting scanned images in the software to 
sure they are not skewed.
e item might not be placed correctly. Straighten the item and 
just the paper guides to center the stack.
e maximum number of pages the ADF input tray and output 

n can hold is 25, depending on the type of media being loaded. 
ake sure to load only 25 or fewer pages in the input tray, and 
move pages from the output bin if they are stacking up to a 
le of more than 25.
e item loaded might not meet the specifications for the ADF. 

ake sure the type of media being loaded meets required 
ecifications. See "Items for the ADF" on page 16.

sing the ADF, the scanner does not feed the item at all.
hatch might not be securely latched. Open the hatch, and then 
e it pressing firmly. See "Clearing jams from the ADF" on 

102 for illustrations.

An item loaded in the ADF ke
� The item does not meet

for the ADF" on page 16
� The item might have som

removed anything such 
the item. See "Selecting

� The item is too small. Th
88.9 by 127 mm (3.5 by

� The item is too large. Th
by 355.6 mm (8.5 by 14
in sections.

The bottom of the scanned im
� The ADF can handle ite

the item is longer, scan 
the correct length, choo
ADF dialog box prompt 

� If sent to a printer, the it
much memory) for the p
printer with more memo
different output type, like
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Pages
approp

To clea
1 Ra

2 Lif
rem

 removed, lift the two green tabs located 
ly remove the green paper lead as 

emove the page might cause damage to 
f the majority of the paper is already 
in roller, use the procedure to clear jams 
age.
Troubleshooting and maintaining

aring jams from the ADF 

 can jam at the beginning or the end of a page. Use the 
riate procedure below to clear the jam and continue.

r jams at the start of a page
ise the hatch.

t the large green tab (located to the left of the roller) and gently 
ove the jammed page.

3 If the item cannot be easily
behind the rollers and gent
shown. 

Note: Using force to r
your originals. I
through the ma
at the end of a p
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4 Rem
lead

5 Clos

ad them into the ADF.

 computer, reselect any settings you had 
 or Scan again.
to TOC Troubles

ove the jammed item from the ADF and replace the paper 
.

e the hatch. Press down firmly until you hear a click.

6 Restack all pages and relo

7 On the ADF prompt on the
changed and click Scan To
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To clea
1 Re
2 Re

3 Ge
(to

e paper from the ADF, lift the ADF lid to 
en the jammed paper from the roller at 
ull it gently from the ADF. 

lly cleared the jam, attach the input tray 
 down firmly on both sides until you hear 

ad them into the ADF. 
computer, reselect any settings you had 
 or Scan again.
Troubleshooting and maintaining

r jams at the end of a page 
move any pages from the ADF input tray.
move the input tray from the ADF. 

ntly pull the paper out of the ADF in the feeding direction 
wards you). 

4 If you still cannot remove th
its fully open position, loos
the rear of of the ADF lid, p

5 When you have successfu
and close the hatch. Press
a click.

6 Restack all pages and relo
7 On the ADF prompt on the 

changed and click Scan To
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Clea

Periodic
to have 
on scan

Clean

You mig
scannin
amounts
scanner
images.

e from the scanner.

ft, lint-free cloth sprayed with a mild 

ss cleaner. Avoid abrasives, acetone, 
d carbon tetrachloride, all of which can 
 scanner glass. Avoid isopropyl alcohol 
an leave streaks on the glass.

 a dry, soft, lint-free cloth.
the power cable to the scanner.
 underside of the glass do not affect the 
s because this area of the glass is 
canner. 
to TOC Troubles

ning and maintaining

ally, the scanner and accessories might need to be cleaned or 
maintenance, especially if you are seeing marks or smudges 
ned images. 

ing the scanner glass

ht need to clean the scanner glass if the ink on items you are 
g can be smudged with your hand or items have excessive 
 of dust or dirt on them. You might also need to clean the 
 glass if there are smudges or other marks on scanned 

To clean the scanner glass
1 Disconnect the power cabl
2 Open the scanner lid.
3 Clean the glass using a so

glass cleaner.
CAUTION Only use gla

benzene, an
damage the
because it c

4 Dry the scanner glass with
5 When finished, reconnect 
Fingerprints or smudges on the
appearance of scanned image
outside the focal point of the s
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Clea

(Some
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the clo

Clea

(Some
on pag
scanni

e from the scanner.
ocate the ADF glass area on the 

ft, lint-free cloth sprayed with a mild 

ss cleaner. Avoid abrasives, acetone, 
d carbon tetrachloride, all of which can 
 scanner glass. Avoid isopropyl alcohol 
an leave streaks on the glass.
 a dry, soft, lint-free cloth.
he power cable to the scanner.
 underside of the glass do not affect the 
s because this area of the glass is 
canner. 
Troubleshooting and maintaining

ning the XPA 

 models only, see "Front panel and accessories comparisons" 
e 3.) Clean the XPA with a dry, soft cloth. If necessary, spray 
th with window cleaner or isopropyl alcohol.

ning the ADF glass

 models only, see "Front panel and accessories comparisons" 
e 3.) You must clean the ADF glass to maintain high-quality 
ng.

To clean the ADF glass
1 Disconnect the power cabl
2 Open the scanner lid and l

scanner glass.

3 Clean the glass using a so
glass cleaner.
CAUTION Only use gla

benzene, an
damage the
because it c

4 Dry the scanner glass with
5 When finished, reconnect t
Fingerprints or smudges on the
appearance of scanned image
outside the focal point of the s
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Unin

The Uni
scannin
See the
informat

s, support, and 

 contains information about these topics:

oubleshooting. Find setup instructions 
ation for issues that can arise when you 

sites and other tools that contain 
ers, and the latest information about 

ct information for your region if you need 

ons. See this topic for the warranty and 
rmation.

breaking information about the HP 
his file is located in the same folder as 

 and the Read Me file are located on the 
age, or on your computer in the 
u allowed the software to install in the 
\Program Files\Hewlett-
.

to TOC Troubles

stalling the software

nstall option of the setup program allows you to remove the 
g software from your computer.
 Setup and Support Guide for installation and troubleshooting 
ion.

Other resource
specifications

The Setup and Support Guide

� Setup instructions and tr
and troubleshooting inform
install the scanner.

� Resources. Discover web
scanning tips, updated driv
your HP scanner.

� Support. Locate the conta
to contact HP.

� Warranty and Specificati
product and regulatory info

See the Read Me file for late-
Precisionscan Pro software. T
the Setup and Support Guide.
The Setup and Support Guide
CD in the folder for your langu
Precisionscan Pro folder. If yo
default location, the path is: C:
Packard\Precisionscan Pro 3.1



108 Back to TOC
Troubleshooting and maintaining



Back 109

ontrols

This sec
cursors 
The HP 
give you
bar prov
sensitive
perform
to TOC

Using software commands and c

tion contains information for using the shortcuts, toolbars, and 
in the HP Precisionscan Pro software. 
Precisionscan Pro contains keyboard shortcuts and toolbars to 
 quick access to software commands. The Status bar and Info 
ide information about the scanned image, and the context-
 cursors provide information on the type of activity you can 

 in the scanning software.
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Usi
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This se
HP Pre
keyboa
menu.
underl
This se
keyboa

ps are available for computers running 
r version 4.0 or greater. See "Resolving 

not generate messages" on page 87.

New
Sca

Sca

Ret

Sav
Prin
Prin
Sca
XPA
XPA
Set

S
L

Pre
Exit

Scan

+Z Return all settings except output type to 
the defaults for this image.

+C Scan and place the selection area on 
the Clipboard.

+A Select the entire scanner glass 
(including blank space).

Remove the selection border.

Zoom in on the selection area.

Zoom out to the original view.

Show or hide the Guided Steps.

Show or hide the toolbar.

Show or hide the Info bar.

Show or hide the Status bar.
Using software commands and controls

ng keyboard shortcuts and the 
nus

ction summarizes the menus and commands in the 
cisionscan Pro software that you can select using the 
rd. To open a menu, press ALT+ the underlined letter for that 

 To perform a command, open the menu and press the 
ined letter for that command.
ction also shows which commands can be performed using a 
rd accelerator (shortcut). 

Note: The Guided Ste
Internet Explore
issues that did 

 Scan CTRL+N Start (preview) a new scan.
n To... CTRL+T Scan and send to a destination, such as 

e-mail.
n to CD Save scanned photos or documents on a 

CD-writer drive.
urn Image to... When using TWAIN, return the scanned 

image to the other program.
e As... CTRL+S Save the selection area as a file.
t CTRL+P Scan and print the selection area.
t Setup Change printing options.
nner Glass
 (Slides)
 (Negatives)

Select the source from which to scan. Only 
one can be selected. 

tings
ave Save settings.
oad Load (use) settings.
ferences Change scanning default preferences.

ALT+F4 Close the HP Precisionscan Pro software.

Reset Tools CTRL

Copy CTRL

Select All CTRL

Unselect All ESC

Zoom In 

Zoom Out

Guided Steps

Tool Bar

Info Bar

Status Bar

Edit

View
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True C
colors

256-C
palette

256-C

Spot C

Grays

Black 

Black 

Editab

Text a

Autom

Rotate

Rotate

Mirror

Resize

Chang

Sharp

Output 

Tools

Adjust colors (hue) and their intensity 
(saturation).

Adjust the contrast (midtones), detail in 
light areas (highlights), and detail in 
dark areas (shadows).

Adjust which values in the image will be 
represented as black or white.

Make colors in the image their 
opposites.

In the scanned image, reduce the 
appearance of undesirable patterns 
that are in a printed original.
to TOC Using software

olor (16.7 million 
)

Choose the output type. Only one can 
be selected. For help choosing an 
output type, show the Guided Steps 
from the View menu.

olor (optimized 
)

olor (web palette)

olor (16-color)

cale 

& White Bitmap

& White Scalable

le Text (OCR)

nd Image

atically Set Type Allow the software to select the output 
type based on the contents of selection 
area.

 Left 90° Rotate the image counterclockwise by 
90 degrees.

 Right 90° Rotate the image clockwise by 90 
degrees.

Reverse the image side-to-side.

 Resize the selection area. This 
changes the output file size also.

e Resolution Change the resolution of the final 
scanned image.

en Adjust the sharpening.

Type

Adjust Color

Adjust Exposure

Adjust Black & White

Invert Colors

Descreen

Advanced
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N

Con

Sea

Wha

HP 

Prod

Use

Ena

Disa

Abo
Pro

Help
Using software commands and controls

ote: Help is available for computers running Internet 
Explorer version 4.0 or greater. See "Resolving issues 
that did not generate messages" on page 87.

tents F1 View Help topics (contents).

rch Look for a Help topic.

t�s This? SHIFT+F1 Display context-sensitive Help for the 
selected software tool or feature.

Scanjet on the Web Connect to the Internet and visit the 
HP Scanjet website.

uct Tour View the product tour.

r�s Manual View the printable user�s manual in .pdf 
format.

ble All Smart Friends Allow helpful alerts to appear when 
potential problems arise.

ble All Smart Friends Prevent helpful alerts from appearing 
when potential problems arise.

ut HP Precisionscan View information about the program, 
version, and copyright.
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HP P
info

The HP 
and an I
about th

Toolb

The HP 
shortcut

ps are available for computers running 
r version 4.0 or greater. See "Resolving 

not generate messages" on page 87.

Click thi

m out to the original view.

tate the image counterclockwise by 90 degrees.

tate the image clockwise by 90 degrees.

turn all settings except output type to the 
aults for this image.

ow or hide the Guided Steps.

play context-sensitive Help for the selected 
tware tool or feature.
to TOC Using software

recisionscan Pro tool and 
rmation bars

Precisionscan Pro software contains a toolbar, a Status bar, 
nfo bar to help you use commands quickly or find information 
e current scanned image.

ar

Precisionscan Pro software displays a toolbar containing 
 buttons for common commands.

Note: The Guided Ste
Internet Explore
issues that did 

s button To

New Scan Start (preview) a new scan.

Scan To... Perform a final scan and send to a destination, 
such as e-mail.

Scan to CD Scan and save the selection to rewritable CD.

Save As... Save the selection area as a file.

Print Scan and print the selection area.

Return Image To When using TWAIN, return the scanned image to 
the other program.

Copy Scan and place the selection area on the 
Clipboard.

Zoom In Zoom in on the selection area.

Zoom Out Zoo

Rotate Left 90 Ro

Rotate Right 90 Ro

Reset Tools Re
def

Guided Steps Sh

Context Help Dis
sof



114 Back to TOC

Add

You ca
toolba

To add
1 On
2 Wh

dia
3 Dr

bu

tom of the preview window and displays 

age
image
e
 selected
recisionscan Pro software
Using software commands and controls

ing tools to the toolbar

n add the Change Resolution tool and the Sharpen tool to the 
r.

 Change Resolution and Sharpen tools to the toolbar
 the Tools menu, click Change Resolution or Sharpen. 
en the dialog box opens, place the cursor over the title of the 
log box, and click and hold down the mouse button. 
ag the cursor to a location on the toolbar and release the mouse 
tton.

Info bar

The info bar appears at the bot
the following information:

� the width of the output im
� the height of the output 
� scale of the output imag
� the output type currently
� the Help button for HP P
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Statu

The stat

� A m
som

� An ic

� One

� A
sc

� Th
or
on
la
fil
to TOC Using software

s bar

us bar displays the following information:

essage about the action you can take when the pointer is over 
e part of the scanning software window or a tool.

on for the transparency adapter when it is in use.

 of the following:

 progress bar that shows when the scanner is scanning or the 
anning software is processing a command.
e number of KB (kilobytes), MB (megabytes), GB (gigabytes), 
 TB (terabytes) in the image in the selection area. This size is 
ly an estimate of the actual size of the image. The file can be 

rger or smaller than the value shown here. The size of a saved 
e depends on the format used to save the file.
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Con

The sh
in the 
Selectio

New
area

Mov
area

Res
area

Res
area

Res
area

Drop

Drop

k a menu item and select a command.
k a list button to select an option.
k a button to turn it on or off, or to increase or 
rease a number.

k, then type a value.

ition this cursor over a light area in the image to 
 its pixel value in the RGB meter and the 
ogram. Click on pixels to set them as the 
light value. In the Transparency Exposure 
stment tool, click to set the RGB value.

ition this cursor over a dark area of the image to 
 its pixel value in the RGB meter and the 
ogram. Click on pixels to set them as the 
dow value.

cates this area is an area in which pixel value is 
available.

k on a tool, field, button, or menu item for pop-up 
 on that item.
Using software commands and controls

text-sensitive cursors

ape of the pointer indicates the type of activity you can perform 
scanning software.
n area cursor

 selection Draw a new selection area.

e selection Drag the selection area to a new location in the 
preview area.
Drag the selection area to another program.
Press CTRL and drag the selection area to the 
Windows desktop or a folder in Windows Explorer.

ize selection 
 horizontally

Appears over handles on the sides of the selection 
area. Drag the cursor to resize the width of the 
selection area.

ize selection 
 vertically

Appears over the handles on the top or bottom of 
the selection area. Drag the cursor to resize the 
height of the selection area.

ize selection 
 diagonally

Appears over handles on the corners of the 
selection area. Drag the cursor to resize both the 
height and width of the selection area.

 allowed The program or folder the image has been dragged 
to accepts this kind of drop.

 not allowed The program into which you are trying to drag the 
image does not accept this kind of drop.

Ready cursor

Ready for activity Clic
Clic
Clic
dec

Typing cursor

Data entry 
accepted

Clic

Pixel value cursor

Highlight 
eyedropper

Pos
see
hist
High
Adju

Shadow 
eyedropper

Pos
see
hist
Sha

Eyedropper and 
the �no� symbol

Indi
not 

What�s This? Help cursor

What�s This? Help Clic
Help
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a b c d

8-bit gra
Used to
images 

24-bit c
Color im
combine
colors. T

256 Co
The pale
colors in

256 Co
A palette
are stan

or Windows bitmap images. See also 

 common bitmap format for Windows 

or FlashPix files. 

phics Interchange Format files.

perText Markup (HTML) files. This 
l.

EG files.
to TOC

Glossary

 e f g h i j k l m n o p q r s t u v w x y z

yscale
 represent black-and-white photos accurately. These grayscale 
contain 256 shades of gray.

olor
ages composed of three 8-bit color channels. When 
d, the red, green, and blue channels provide up to 16 million 
his is also referred to as true color.

lor (optimized palette)
tte for an image which comprises the 240 most common 
 the image plus the 16 basic colors.

lor (web palette)
 or color table containing red, green, and blue pixel colors that 

dard for images embedded in Web pages or .html files. 

.bmp
The filename extension used f
Windows bitmap.

.dib 
Device Independent Bitmap. A
programs.

.fpx
The filename extension used f

.gif 
The filename extension for Gra

.htm
The filename extension for Hy
extension also appears as .htm

.jpg
The filename extension for JP
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.pcx
The fil

.pdf
The fil

.png
The fil

.rtf
The fil

.tif 
The fil

.txt 
The fil

.wmf 
The fil

a

acquir
A com
Acquir
returns

 using or that is currently selected. A 
lor to distinguish active from inactive 

pter.

er.

ner bed that the ADF uses to scan 
y.

 angled lines or object edges that result 
een pixels. Seen in both black-and-

s. Sometimes called Jaggies.

sitions between pixels, reducing the 

ace a scan would require if saved to 
ize value does not apply if the output 
 it only applies to an image 
Glossary

ename extension for Paintbrush files.

ename extension for Portable Document Format (PDF) files.

ename extension for Portable Network Graphics (PNG) files.

ename extension for Rich Text Format files. 

ename extension for TIFF or TIFF compressed files. 

ename extension for plain text files.

ename extension for Windows metafiles.

e
mand offered by programs that support TWAIN. Selecting 
e takes you directly to a selected scanning software, and then 
 the scanned image to the requesting program. 

active program
The program you are currently
program�s title bar changes co
programs.

Active XPA
Or XPA. See transparency ada

ADF
See automatic document feed

ADF glass
The piece of glass on the scan
documents from the feeder tra

aliasing
The visibly jagged steps along
from sharp tonal contrasts betw
white images and color image

anti-aliasing
A technique that smooths tran
jaggedness of curved lines.

approximate size
Reflects the amount of disk sp
your computer. Approximate S
type for the scan is set to text;
representation of the scan.
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auto(ma
Automa
bed, not

automa
Abbrevia
multiple

auto(ma
A featur
optimal 
resolutio
is select
type.

b

bit dept
The num
image. A
provides
indexed
A 24-bit
depth, th

bitmap
A type o
matrix o
bitmap, 

ontain only black pixels and white pixels, 
ach pixel represents one bit.

 are black & white images made up of 
ages must be saved as .wmf files.

l
ividing point for black-and-white pixels in 
 White Bitmap (raster) output type. All 

be output as black, and all pixels above 
 white.

 image indicating scanning boundaries. 
election border and handles that are 
gion.

) and dark (shadows) in an image. In 
wer the brightness, the closer the image 
 brightness, the closer the image will be 
t be confused with contrast, which 
the darkest and lightest shades in an 
 the intensity of shades in an image, 
number of shades in the image.
to TOC

tic) cropping
tic cropping displays only the item(s) detected on the scanner 
 any of the surrounding area.

tic document feeder
ted ADF, it is an optional accessory that allows you to scan 

 pages.

tic) resolution
e of the scanning software that automatically applies the 
output resolution to the selection area. For example, output 
n is automatically set to 200 when the True Color output type 
ed, and set to 300 for the Black & White Bitmap (raster) output 

h
ber of bits used to define the shade or color of each pixel in an 
 1-bit image is black and white. An 8-bit grayscale image 
 256 shades of gray. An 8-bit color image provides 256 

 colors and is associated with a specific palette or color table. 
 image provides over 16 million colors. The greater the bit 
e larger the size of the saved file. See also file size.

f black-and-white, gray, or color image or picture made up of a 
f individual pixels or dots. Often referred to as raster, raster 
or raster image. 

black & white bitmap
Black & white raster bitmaps c
no colors or shades of gray. E

black & white scalable
Black & white scalable images
lines rather than dots. These im

Black & White (threshold) too
This tool lets you change the d
an image that uses the Black &
pixels below the threshold will 
the threshold will be output as

border
A line surrounding the scanned
Clicking the image reveals a s
used to define the scanning re

brightness
The balance of light (highlights
black-and-white images, the lo
will be to black. The higher the
to white. Brightness should no
measures the range between 
image. Brightness determines
while contrast determines the 
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c

click
To pre
press 

clippe
Pixels 
would 

CMYK
Cyan, 
compo
pigme

conver
Text th

color b
The pr
range.
that in

color c
The re

color c
The pr
device

onitor can display at once. Most PC 
6 colors), 16-bit color (about 65,000 

million colors), and 32-bit color. The 
re lifelike images look on screen.

balance and hue.

at determine how the scanner buttons 
 operations.

s questions related to specific features 
ow. The Help is provided in six ways: 
his? Help, Smart Friends, Status bar 

ds. 

t and darkest shades in an image. An 
w gray shades between black and 
ated by stark light and dark tones. An 

any shades of gray and tends to look flat 
g the highlight, shadow, and midtone 

ber of bits used for exposure 
and black-and-white threshold 
er the bit depth, the finer the level of 
e manipulation functions.
Glossary

ss and release the left mouse button once. Right-click means to 
and release the right mouse button once.

d pixels
in an image that are extremely light or extremely dark and that 
lose detail when the image is printed or displayed.

Magenta, Yellow, Black. The color model in which all colors are 
sed of Cyan, Magenta, and Yellow, the primary colors of 

nts like ink, plus Black. Printers use CMYK to print in color.

ted text 
at has been rendered into digital format by an OCR program.

alance 
eservation of balance between colors throughout the tonal 
 Color balance is particularly important when scanning objects 
clude neutral tones (grays) or large areas of consistent color.

hannel 
d, green, and blue components from which colors are created.

orrection 
ocess of adjusting an image to compensate for input and output 
 characteristics or color flaws in the original image.

color depth
The number of colors that a m
monitors display 8-bit color (25
colors), 24-bit color (about 16 
higher the color depth, the mo

color wheel 
A tool used to adjust the color 

configure 
The ability to adjust settings th
and scanning software perform

context-sensitive Help 
Context-sensitive Help answer
in the currently displayed wind
Text Labels, ToolTips, What�s T
messages, and Help comman

contrast 
The range between the lightes
image with high contrast has fe
white and appears to be domin
image with low contrast has m
and dull. Change contrast usin
settings.

control range
This range determines the num
compensation, shadow detail, 
adjustment displays. The high
control in adjusting these imag
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crop 
To elimin

d

default s
Predete
the your
are set f
White T
settings

density 
The abil
density 
to both b

descree
The pro
pattern, 
appear i

destinat
The file,
used. Ex

device d
Software
display, 

mputer monitor can display both 
en resolutions are typically 640 x 480 

), or 1024 x 786.

pixel colors when reducing the color 
an improve transitions between colors 
to 8-bit format.

main program window.

entation, document refers to an original 
t and images. It also means an original 
atic document feeder.

tton twice in rapid succession.

dots in a linear inch. DPI measurements 
tion of printers and scanners, where 

made up of a series of round dots. The 
gher the resolution.
to TOC

ate portions of an image from the final scan. 

ettings
rmined settings in the scanning software that define levels on 
 behalf. Default settings in the HP Precisionscan Pro software 
or Output Type, Output Resolution, Color, Exposure, Black & 
hreshold, and Sharpen Level. You can override default 
.

ity of a material to absorb or transmit light. The greater the 
of a material or object, the more black it contains. This applies 
lack-and-white images and color images.

n
cess of removing an unwanted pattern, such as a moiré 
that appears in a printed original so the pattern does not 
n the scanned image.

ion 
 program, or hardware device where the scanned image will be 
amples include a printer, a Web page, or an e-mail program.

river 
 that the system uses to communicate with devices, such as a 

printer, mouse, or scanner.

display resolution 
The number of pixels that a co
horizontally and vertically. Scre
(VGA), 800 x 600 (super VGA

dithering 
The process of approximating 
depth of an image. Dithering c
when reducing a 24-bit image 

dock 
To attach a tool window to the 

document
For the purposes of this docum
item containing text or both tex
item scanned using the autom

dots per inch 
See dpi.

double-click 
To press and click a mouse bu

dpi
Dots Per Inch. The number of 
are used to describe the resolu
printed images and words are 
greater the DPI number, the hi
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drag
To mo
selecti
to mov

drag-a
To mo
object 
anothe
droppi
receivi

drop-d
A list o
comm

e

editab
Text th
modify
on the
style, a
phrase

e-mail
A netw
E-mail

export
To sav

ess and contrast, in an image. 

saved. Certain file formats enable 
sors to insert, open, or import scans. 

lude .bmp, .jpg, and .tif. Common text 
rtf (Rich Text Format). 

he file size of scanned images is 
ype, output type, and scaling. To reduce 
r example, you could decrease bit depth 

he selection area, that is sent to a 
nter, the Clipboard, or another program. 

idth of the final image to be scanned. 

cessing, but creates larger file sizes. 
 the .fpx extension, can be used on 
rms. The format was developed by 
Picture, and Microsoft.
Glossary

ve an object on screen. Place the cursor over the image or 
on area, hold the left mouse button down, and move the mouse 
e the object.

nd-drop 
ve an object to a new location and keep it there. Click on the 
and drag it to a new location, such as an open document in 
r program, and release the mouse button. When dragging-and-

ng between programs, a copy of the object is placed in the 
ng program.

own list (or menu)
f items that appears when you click on or pass the cursor over a 
and such as File or Edit.

le text 
at is converted from a scanned image into characters you can 
 in a word processor or other text-editing program. Depending 
 capabilities of your program, you can change the font, size, 
nd other attributes of editable text, as well as edit words or 
s.

 
ork over which you can transfer messages and electronic files. 
 is also sent via Internet browsers. 

e a file in a particular file format for use in other programs.

exposure 
The amount of light, or brightn

f

file format
The format in which a scan is 
programs such as word proces
Common graphics formats inc
formats include .txt (text) and .

file size 
The number of bytes in a file. T
determined by resolution, file t
the file size of photographs, fo
or resolution. 

final scan 
The actual image, defined by t
destination such as a file, a pri

final size 
The approximate height and w

FlashPix 
A format that allows faster pro
FlashPix files, which save with
Windows and Macintosh platfo
Hewlett-Packard, Kodak, Live 
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flowed t
The Flow
images 

framed 
The Fra
as close
Text ma
expand 

focus 
Refers t

front pa
The are
for send

g

gamma
The con
Adjustin
values o
the shad
images 
among c

photographs in which individual pixels 
reas of white between them, thus 
 quality of the image. Graininess can 
uality original or reduce the bit depth of 
g or halftoning.

ported by many Windows programs. 
ort 256 colors. Graphics Interchange 
 filename extension .gif.

aining shades of gray, not just black and 
ach pixel contains multiple bits of 
des of gray to be recorded and 
uce up to 16 levels of gray, and eight 
 of gray. Grayscale is commonly used 

otographs but is also effective in 
rawings. 

ern of dots that tricks the eye into seeing 
nes are common in all printed materials. 
photographic originals can result in 

an as it will appear at its destination.
to TOC

ext
ed Text option converts output into one column, placing 

as closely as possible to the appropriate text.

text
med Text option places text and images in a frame, positioned 
ly as possible to the way they appear in the original document. 
y be more difficult to edit extensively since the frames may not 
to hold additional text.

o the sharpness of an image.

nel
a on the front of the scanner hardware containing the buttons 
ing an item to a destination or changing settings.

 
trast that affects the mid-level grays or midtones of an image. 
g the gamma of an image allows you to change the brightness 
f the middle range of gray tones without dramatically altering 
ows and highlights. This applies to both black-and-white 

and color images. The default setting of 2.2 ensures integrity 
omputer systems.

grainy 
Refers to images, pictures, or 
are relatively large and have a
reducing the overall perceived
occur when you scan a poor-q
the scanned image by ditherin

Graphics Interchange Format
A graphic file format that is sup
Files saved in this format supp
Format files are saved with the

grayscale 
An original or output type cont
white. In a grayscale image, e
information, allowing more sha
displayed. Four bits can reprod
bits can reproduce 256 shades
for black-and-white original ph
maintaining shading in pencil d

h

halftone 
An original composed of a patt
shades of gray or color. Halfto
Scanning halftones instead of 
lower final image quality.

height
The vertical dimension of a sc
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highlig
The lig
compu

histog
A grap
intensi
Histog
value o

HP Sca
A softw
and ot

HP Pre
The sc
before
resizin

HP Sh
An aut
destina

HTML 
HyperT
for the
and wi

f a visible color that enables you to 
. Six hues are especially important in 
inting: red, yellow, green, cyan, blue, 
ed by the frequency of the wave of light 
 saturation.

e displayed on a computer screen or 

 bitmapped drawings and photographs.

ed in bytes and displayed in the Status 
ay vary, depending on the file type.

 a document from another program.

ars in the lower, left corner of the screen 
ght of the output image, the scale 
rrently selected, and a Help button.
Glossary

hts 
htest portion of an image, usually reproduced as white on the 
ter screen or when printed. 

ram 
hical representation of the concentration of pixels at each 
ty or gray level in the selection area of the scanned image. 
rams help determine the optimal highlight, shadow, or threshold 
f an image. 

njet Copy Utility 
are utility used to select number of copies, destination printer, 

her copy options.

cisionscan Pro software
anning software that HP provides for previewing an image 
 sending it to a destination; making changes, such as resolution, 
g, and contrast; and saving images as files.

are-to-Web 
omated feature that sends scanned images directly to a 
tion on the Web. Links are available only in English.

ext Markup Language. A language used in creating documents 
 World Wide Web. Documents can be saved in HTML format 
ll have an .htm or .html extension.

hue 
The distinctive characteristic o
distinguish it from other colors
photography, scanning, and pr
and magenta. Hue is determin
that creates the color. See also

i

image 
An electronic picture that can b
saved to a disk. 

image editor
A program that lets you modify

image size 
The size of the image express
bar. File size and image size m

import
To bring a scanned image into

Info bar 
A form of assistance that appe
and displays the width and hei
percentage, the output type cu
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interface
The con
either a 
scanner

interpol
Resoluti
hardwar
able to e
for enlar

interpola
The pro
new pixe
neighbo

invert 
To rever
image, b

item
The phy
scan. O
image.

 between black and white, or areas of 
ged edges can be avoided by scanning 
r output device, or by not scaling the 

oup. A compressed file format that 
aster file access. This format can reduce 
 when the file is decompressed and 

 saved with the filename extension .jpg. 

keystrokes that allows you to quickly 

h or image that is wider than it is tall. 
 is wide, it is called portrait orientation.
to TOC

 connection
nection between the scanner and the computer. This can be 
USB, parallel, or SCSI connection depending on the model of 
 and your operating system.

ated resolution 
on that is changed in the scanning software rather than in the 
e. For example, if your scanned image is 600 dpi, you might be 
nhance it to 1200 dpi in the scanning software. This is useful 
ging small images.

tion 
cess of increasing the resolution of an image by the addition of 
ls throughout the image, the colors of which are based on 

ring pixels.

se the colors in an image (for example, in a black-and-white 
lack areas are turned white and white areas are turned black). 

sical drawing, photo, collage, etc. you place in the scanner to 
nce it is scanned, it is referred to as an image or scanned 

j

jagged 
Refers to the uneven transition
color, in a scanned image. Jag
at a higher resolution than you
image after scanning it.

JPEG 
Joint Photographic Experts Gr
reduces file size and enables f
image quality and performance
recompressed. JPEG files are

k

keyboard shortcuts 
A keystroke or combination of 
accomplish common tasks.

l

landscape 
The orientation of a photograp
When an image is taller than it
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m

maxim
This o
softwa
24 bits
graysc

midton
The gr
70% b
image
proper
the im

moiré
An und
screen
when y
magaz
scanne

n

negati
This X
slide h
of neg

illumination and improves image quality 
e it into the negative holder after the 

 optional transparency adapter that is 
Negatives are then placed in the 

(unwanted specks) in an image by 
o minimize the effects of noise in the 

on.

y that recognizes letters in a scanned 
ASCII characters, or editable text.

r, the resolution at which the scanner 
erpolated resolution, resolution. 

ntains the pixel colors present in an 
Glossary

um pixel depth
ption enables higher bits per pixel when the scan is sent to the 
re. When it is off, 8 bits per pixel are returned for grayscale and 
 for color. When it is turned on, 16 bits per pixel are returned for 
ale and 48 bits for color. 

es 
ay shades of an image. Midtones are usually between 30% and 
lack. Midtone control adjusts the brightness of gray levels in the 
 so that the lightest and darkest portions of the image can be 
ly displayed on your monitor. The higher the setting, the brighter 
age appears on your monitor.

esirable pattern in color printing that results from incorrect 
 angles of overprinting halftones. Moiré patterns usually result 
ou scan a halftone, when you scan images taken directly from a 
ine, or when you scale an image in an image editor after it is 
d.

ve holder
PA piece holds negative strips for scanning. Insert it into the 
older on the bottom of the XPA light source for proper scanning 
atives.

negative light shield
This XPA piece blocks excess 
when scanning negatives. Slid
chosen negative strip.

negative template 
The cutout that comes with the
placed on the scanning glass. 
template.

noise reduction
This option reduces the noise 
applying software algorithms t
scanner electronics.

o

OCR 
See optical character recogniti

optical character recognition
Abbreviated OCR. A technolog
image and converts them into 

optical resolution 
The true resolution of a scanne
captures images. See also: int

optimized palette 
A palette or color table that co
image.
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original
The orig

output 
The file 

output d
The actu
the size
affects o

output ty
The type
type rev

p

Paintbru
A bitmap
UNIX, a
support 
64,000 p

palette 
A subse
be displ
that allo
monitor.
individua
color pa

 your monitor is set to a color depth of 
grams. When you switch programs, the 
ecomes the system palette, and all other 
s accurately as possible with the new 

ic documents to someone�s fax 
lso allows receiving of faxed documents 
x machine.

element) that can be assigned an 
y and can be displayed on a computer 
 arranged in a grid pattern to make up 
creen.

mat. A compressed image file format 
t replace GIF because of copyright 
 non-lossy compressed, supports 
ith the True Color output type, which 

 image that is taller than it is wide. An 
ll is called a landscape orientation.

late with a rectangular cutout that 
e XPA light source on the scanner bed.
to TOC

 
inal document or picture to be scanned. 

that is generated by the scanning process.

imensions 
al height and width of an image when saved. You will not see 

 changes to your image in the Preview area since image size 
nly the final scan.

pe 
 of file that is generated during the scanning process. Output 

eals the bit depth of the image.

sh 
 file format (.pcx extension) supported by MS-DOS, Windows, 

nd other platforms, and numerous programs. Paintbrush files 
24-bit color and can have a maximum image size of 64,000 by 
ixels.

t of the color look-up table that establishes the colors that can 
ayed on the monitor at a particular time. The only color depth 
ws multiple palettes is the 256 (or 8-bit) color setting for your 
 At a color depth of 256 colors, each program (or even each 
l image used or edited in a program) can have a different 

lette.

palette flashing 
The flashing that occurs when
256 colors and you switch pro
palette of the active program b
programs redraw themselves a
colors.

PC fax program
A program for sending electron
machine or PC fax program. A
to the computer instead of a fa

pixel 
The smallest element (picture 
independent color and intensit
screen. Pixels are square dots
the images displayed on the s

PNG
Portable Network Graphics for
suitable for the Web that migh
issues with GIF format. PNG is
interlacing, and can be used w
GIF cannot.

portrait 
Orientation of a photograph or
image that is wider than it is ta

positioning plate
This XPA piece is a large temp
orients proper placement of th
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postin
Term f

Power
An ene
when t

PPI 
Pixels 
scanne

prefere
Refers
softwa
of tool
use of
scanne
scanni

previe
A featu
scanni
adjustm

previe
The re
display

 of dots per inch (dpi) the printer is 
er printers have resolutions of 600 dpi, 
tions of 300 dpi for photographs and 600 
 have resolutions of 1200 or 2400 dpi. 
oother the output and the greater the 

d colors the device can describe.

verview of the scanner�s capabilities 
mpleted. It appears each time the 
s it is specifically disabled. It is also 

, or color image or picture made up of a 
ts. This is also referred to as a bitmap.

s per inch (dpi) are scanned, displayed, 
 the greater the amount of detail that is 
ize. The final output device (monitor, 
etermines the resolution of the image. 
ture at 600 dpi (the optimum) and your 
 only 300 dpi, the printed image will be 
Glossary

g scans
or scanning items directly to a website.

 Save
rgy conservation method that reduces power consumption 
he scanner is idle for a period of time.

Per Inch. A measurement of resolution for monitors and 
rs where the individual element is a square pixel.

nces
 to your preferred method of using the scanner. The scanning 
re automatically saves certain preferences, such as the location 
bars and the destination of a scan, that it detects during normal 
 the scanner. Some preferences are restored each time the 
r is used, while others are maintained only throughout a 

ng session.

w 
re that displays a scanned image so you can view it in the 
ng software. You can then select an area to be saved; make 

ents to the tone, color, and size; and save the final image.

w window
ctangular area in the software where the scanned image is 
ed.

printer resolution 
A measurement of the number
capable of printing. Typical las
typical ink printers have resolu
dpi for text, while imagesetters
The more dots per inch, the sm
number of grayscale levels an

product tour
The product tour provides an o
and how scanning tasks are co
scanning software starts, unles
available in the Help menu.

q

r

raster 
A type of black and white, gray
matrix of individual pixels or do

resolution 
The measure of how many dot
or printed. The greater the dpi,
visible, and the larger the file s
printer) for a scanned image d
For example, if you scan a pic
printer is capable of printing at
no more than 300 dpi.
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RGB 
Red, Gr
of a vary
primary 
monitor.

rich text
A forma
original 
compati
with the

right-clic
To press

rotate to
To rotate
counterc

s

saturatio
The inte
saturatio
saturatio

scale 
To reduc
aspect r
dimensi

ph, or text as a digital electronic image 
o refers to the image that has been 

er where you place items to scan. 
canner glass.

ner where you place items to scan. 
canner bed.

r, which holds the original paper flat for 

clude the flatbed, transparency-slides, 

er of lines per inch (lpi) that a screen 
lpi.

r border drawn around a portion of the 
e selection area is scanned when you 
opy to the clipboard, or print.
to TOC

een, Blue. The color model in which every color is composed 
ing amount of red, green, and blue, which are the three 
colors of light. RGB is used to display colors on a computer 
 

 format 
t for text files. Rich Text Format preserves all formatting in the 
text document. It converts formatting into instructions that 
ble programs can interpret. Rich Text Format files are saved 
 filename extension .rtf.

k 
 and release the right mouse button once.

ol 
 the entire scan 90 degrees clockwise or 90 degrees 
lockwise.

n 
nsity of color in a specific hue. An image with high color 
n has vivid color. A black-and-white photograph has zero 
n. See also hue.

e or increase the physical size of an image while maintaining 
atio (the ratio of the horizontal dimension to the vertical 
on).

scan
To capture a picture, photogra
using a scanner. This term als
scanned.

scanner bed 
The glass surface of the scann
Sometimes referred to as the s

scanner glass 
The glass surface on the scan
Sometimes referred to as the s

scanner lid
The lid, or cover, of the scanne
scanning.

scanning source 
Scanning (or scan) sources in
and transparency-negatives.

screen resolution 
The measurement of the numb
can display. This is usually 75 

selection area 
The area inside the rectangula
image in the Preview area. Th
drag-and-drop, save to a file, c
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setting
Saving
scanne
future.

shado
The da
compu
shado

sharpe
To enh

slide h
This X
of the 

slide li
This X
when s
slide(s

Smart 
Smart 
potent
resolu
Friend
e-mail

age is retrieved for use in a document. 
ll an image from a source, such as the 

e.

arge areas of color in a scanned image 
the area.

askbar that can be used to start a 
nge settings, and open documents. 

t Windows program screens that shows 
ction in progress.

ing a Web palette plus more shades of 

e of the Windows Desktop. The Taskbar 
ns for each open program, and a status 

s saved in the following formats: .txt, 
Glossary

s
 settings allows you to save a set of settings used with one 
d image and reuse the settings with an image scanned in the 

 

w
rkest area of an image, usually reproduced as near black on the 
ter screen or when printed. The range between highlight and 

w determines the quality and color differentiation in the image. 

n 
ance the detail in an image. 

older
PA piece holds slides for scanning. It is attached to the bottom 
XPA light source.

ght shield
PA piece blocks excess illumination and improves image quality 
canning slides. Slide it into the slide holder after the chosen 

).

Friends
Friends are tips that appear automatically to notify you of 
ial problems. For example, if you are setting a very high 
tion but want to use e-mail to send the scanned image, a Smart 
 would alert you that the file will probably be too large to send in 
.

source 
The program from which an im
TWAIN-compliant programs pu
HP Precisionscan Pro softwar

spot color 
A software function that finds l
and applies a uniform color to 

Start button 
The button in the (Windows) T
program quickly, find files, cha

status bar 
The area at the bottom of mos
information about the current a

system palette 
A palette or color table contain
gray and the 16 VGA colors. 

t

Taskbar 
A toolbar that docks to the edg
includes the Start button, butto
area. 

text
As it relates to scanning, text i
searchable .pdf, .htm, and .rtf.



Back Glossary 131

threshol
The pro
and all a
graysca

TIFF 
Tagged 
capable
especia
program
extensio

TIFF com
Tagged 
images,
is recom
program
compres
files are

tone 
The ove
color.

toolbar 
The are

ToolTip 
A brief d
control (
window.

al accessory used to scan negatives 
is plugged into the scanner, and a 
e transparency above the glass.

 with 24-bits per pixel per color.

ications protocol for sending instructions 
r) and receiving image data back from 
m that supports TWAIN, you can start 

ware directly from that program.

king an image proportionately in both 
ctions. 

ace for connecting peripherals, such as 

braic equations to define the various 
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ding 
cess of rendering all areas darker than a set value as black, 
reas lighter than a set value as white. Useful when converting 
le images to black and white. 

Image File Format. A bitmapped file format for images, 
 of storing up to 24-bit depth images. TIFF file format is 
lly appropriate for scanned images and is supported by many 
s and computers. TIFF files are saved with the filename 
n .tif.

pressed 
Image File Format, compressed. A bitmapped file format for 
 capable of storing up to 24-bit depth images. TIFF file format 
mended for scanned images and is supported by many 
s and computers. TIFF compressed files use data 
sion to reduce the size of the resulting file. TIFF compressed 

 saved with the filename extension .tif.

rall effect produced by the combination of lighting, shade, and 

a that contains buttons for a program's controls.

escription that appears when the mouse pointer pauses over a 
such as a menu item or toolbar button) in a software program�s 

transparency adapter
Abbreviated as XPA. An option
and slides. An XPA connector 
template is used to position th

True Color 
An image type that is rendered

TWAIN 
An industry-standard commun
to hardware (such as a scanne
them. If you are using a progra
the HP Precisionscan Pro soft

u

uniform scaling 
A method of stretching or shrin
the vertical and horizontal dire

USB 
Universal Serial Bus. An interf
scanners, to a computer.

v

vector 
A type of image that uses alge
lines and curves of the image.
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w

Web p
A pale
is stan
consis
153, 2

WIA
Windo
scanne

width
The ho

Windo
A bitm
progra
color. W
.bmp.

Windo
A file f
data b
saved

x

XPA
See tr

lugs into the scanner. It fits into the 
 backlighting in order to properly scan 
 images. (It may also be used as a light 

ify, the image in the Preview area so 
ade to the image. This action does not 

d, printed, copied to the clipboard, or 
Glossary

alette 
tte or color table containing red, green, and blue pixel colors that 
dard for images embedded in Web pages or .htm files. It 
ts of 216 entries of all combinations of the values 0, 51, 102, 
04, and 255.

ws Imaging Application. The method Word uses to bring 
d images into an open Word document. Similar to TWAIN.

rizontal dimension of your scan as it is sent to its destination.

ws bitmap 
apped file format for pictures, supported by most Windows 
ms. Windows bitmap files support 1-, 4-, 16-, 24-, and 32-bit 

indows bitmap files are saved with the filename extension 

ws metafile 
ormat supporting 24-bit color used to store and exchange image 
etween Windows-based programs. Windows metafiles are 
 with the filename extension .wmf.

ansparency adapter.

XPA light source
This XPA piece is a light that p
positioning plate and provides
transparent slide and negative
box for viewing slides.)

y

z

zoom scan 
The ability to enlarge, or magn
that finer adjustments can be m
enlarge the picture that is save
dragged into another program.
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Ind
A
About H
abrasive
accesso

troubl
using

accurac
acquirin
active p
adapter
addition
ADF (au

capac
clean
docum
feedin
jams,
jams,
loadin
mode
Scan 
scann
troubl

Adjust B
shortc
using

Adjust C
shortc
using

Adjust E
shortc
transp
using

adjustin
black 
bright
color 
contra
highlig
hue 5
midto
outpu
prefer

Change Resolution command
shortcuts 111
using 46

changing. See adjusting
characters, incorrect 96
checklist, troubleshooting 85
cleaning

ADF 106
scanner 105
XPA 106

clearing ADF jams 102, 104
click, definition 120
clipped pixels

checking for 53
definition 120

CMYK, definition 120
collating copies 33
color balance

adjusting 56
definition 120

color channels
changing 59
definition 120

color copies, making 33
Color copy button 25
color correction

automatic 70
definition 120
highlights, adjusting 51
hue, adjusting 56
midtones, adjusting 50
saturation, adjusting 57
shadows, adjusting 52

color depth
definition 120
output types 43

color images, output types for 44
color wheel

adjusting hue 56
definition 120

colored paper
adjustments for 59
copying from 94
ex
P Precisionsca
 cleaners, avoi
ries
eshooting 100
 75
y, OCR 73
g scans 71
rogram, definiti
, transparency. 
al pages, prom
tomatic docum
ity 101

ing 106
ent specificatio

g problems 10
 clearing 102, 1
 preventing 101
g 76
ls including 3
dialog box 76
ing from 76
eshooting 101
lack & White T
uts 111

 58
olor command
uts 111

 56
xposure comm
uts 111
arent items 81

 50, 51, 52
g
and white thres
ness 50
channels 59
st 46
hts 51

6
nes 50
t levels 54
ences for scan
n Pro command 112
ding 105, 106

on 118
See XPA
pt for 36
ent feeder)

ns 16
1
04

hreshold command

and

hold 58

ner buttons 34

preferences for scanning software 68
saturation 57
shadows 52
tonal resolution 71

Adobe Acrobat Reader 63
 See also .pdf files

Advanced menu, shortcuts for 111
alarms, highlight and shadow 53
alcohol, cleaning with 105, 106
alerts

highlight 53
shadow 53
Smart Friends 40

aliasing, definition 118
anti-aliasing, definition 118
applications. See programs
approximate size

definition 118
files 115

Area to scan options 36
areas, selecting

automatic 70
using cursor 42

ASCII text, saving as 63
attaching files to e-mail 30, 36
automatic cropping, definition 119
automatic document feeder. See ADF
automatic exposure adjustment 70
automatic resolution 119
Automatically Set Type

option 43
shortcut 111

B
b&w copy button 25
balance, color

adjusting 56
definition 120

bed, scanner
definition 129
printing entire 64
selecting entire 42

best quality settings 69
bit depth, definition 119

bitmap files (.bmp)
definition 119
using 63

black and white bitmaps
adjusting colors in 59
definition 119
shortcut for 111

black and white copies, making 33
black and white images

inverting colors 49
output types for 44

black and white scalable
definition 119
shortcut for 111

black and white threshold
changing 58
definition 119

black areas, adjusting 52
black eyedropper tool 52
black images, troubleshooting 92
black output levels, changing 54
blank pages, troubleshooting 92, 94
blue color channel 59
blurry images

sharpening 48
troubleshooting 91

.bmp files (bitmap)
definition 119
using 63

books, scanning pages from 15
borders, selection 42
boxes, around slides or negatives 95
brightness

adjusting 50
definition 119

bulbs, broken 100
business cards, scanning 15
Button Options dialog box 34
buttons. See scanner buttons

C
Cancel button 25
capacity, ADF 101
carbon paper, scanning 15, 16
CDs, scanning to 66
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colors
automati
convertin
highlight
hue, adju
inverting
midtones
negative
output ty
RGB val
saturatio
shadows
slides, tr
tonal res
troublesh

compariso
compresse
Configurat
Contents, 
context-se

 See also
shortcuts
using 40

contrast
adjusting
definition

control ran
Controls ta
converting
copies, ma

quality, t
troublesh
using HP
using sc

Copy butto
using 33

Copy comm
shortcuts
using 65

Copy Utilit
copying an

toolbar s
using Cli

E
edges not printing 93
Edit menu, shortcuts for 110
editable text

accuracy of 73
definition 122
languages 70
options for 70
output types for 44
troubleshooting 96

Editable Text (OCR) option, shortcut for 111
8-bit grayscale, definition 117
E-mail button

identifying 24
options 35
using 31

e-mailing scans
attaching files 30
file sizes 46
supported programs 30
troubleshooting 97
using scanner buttons 31

Enable All Smart Friends 40, 112
Enable Scan Another Page Dialog 69
End Task 85
enhancing details 48, 52
error messages 87
Exit 110
exposure

automatic adjustments 70
definition 122

Extend lamp time out 69
eyedropper tools

black 52
functions of 116
viewing RGB values 55
white 51

F
fabric, scanning 15
FAQs (frequently asked questions) 20
features, scanner models 3
feeding problems, ADF 101
file formats, types of 63
File Open command 88
to TOC

c adjustment 70
g to black and white 59

s, adjusting 51
sting 56

 49
, adjusting 50
s, troubleshooting 95
pes 43
ues, viewing 55
n, adjusting 57
, adjusting 52
oubleshooting 95
olution 71
ooting 92, 94

n, features 3
d file formats 63
ion dialog box, opening 34
Help topics 112
nsitive Help
 Help, online
 112, 113

 46
 120
ge, definition 120
b options 71
 text. See OCR
king
roubleshooting 93
ooting 98
 Copy Utility 14

anner button 33
n

and
 110, 113

y, HP 14
d pasting
hortcut 113
pboard 65

correction, color
automatic 70
definition 120
highlights, adjusting 51
hue, adjusting 56
midtones, adjusting 50
saturation, adjusting 57
shadows, adjusting 52

cover, scanner 129
crooked images, troubleshooting 92
crooked pages, troubleshooting 101
cropping

definition 121
scanning area 42

Current OCR Language option 70
cursors

black eyedropper 52
context-sensitive 116
dragging and dropping 65
Ready 116
Selection Area 116
Typing 116
white eyedropper tool 51

customer support, resources for 107
customizing

preferences for scanning software 68
resolution values 70
scanner buttons 34
settings 68

cut off pages, troubleshooting 94

D
dark areas

adjusting 52
troubleshooting 91

darkening images 50
dashed boxes 95
decreasing

details for transparent items 82
details in dark areas 52
details in light areas 51
saturation 57

default programs, changing 34, 96
default settings

definition 121
returning to 48
scanner buttons, changing 34

deleting selection areas 42

density, definition 121
depth, color

definition 120
output types 43

Descreen command
shortcuts 111
using 60

desktop, dragging and dropping to 66
destinations

defined 26
E-mail button options 35
scanning to 27
select button 24
troubleshooting 97

details
black and white threshold 58
clipped, checking for 53
decreasing in dark areas 52
decreasing in light areas 51
enhancing 52
increasing in dark areas 52
increasing in light areas 51

device driver, definition 121
.dib files (device independent bitmaps) 117
dimensions

paper sizes 15, 16
resizing images 45

Disable All Smart Friends 40, 112
display resolution

definition 121
image quality 21
output types for 44

distribution, pixel 56
dithering, definition 121
dock, definition 121
documentation, printing 13
documents, definition 121
dots per inch (dpi), definition 121

 See also resolution
dots, troubleshooting 91
double-click, definition 121
dpi (dots per inch), definition 121

 See also resolution
dragging and dropping

between programs 65
definition 122
to desktop 66

drawings, output types for 44
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file sizes
definition
options 
reducing
resolutio
status ba

files
attaching
dragging
saving to

film, scann
adjusting
from XPA
negative
slides 77
troublesh

final scans
definition
options 
selecting

fingerprints
flashing pa
FlashPix fi

definition
using 63

flipping ima
flowed text

definition
option 7

focus, defi
folders, dra
font sizes, 
formats, fil
formatting,

options 
troublesh

.fpx files (F
definition
using 63

framed tex
definition
option 7

free websi
frequently 
front panel
frozen prog

images
darkening 50
definition 124
file formats 63
highlights, adjusting 51
inverting colors 49
lightening 50
midtones, adjusting 50
mirroring 47
output levels, adjusting 54
resizing 45
rotating 47
sending to programs 61
shadows, adjusting 52
sharpening 48

Import command 88
importing scans 71
increasing

details 52
image clarity 48
saturation 57

info bar 114, 125
Info Bar command 110
input tray, ADF

loading 76
troubleshooting 101

insufficient memory, troubleshooting 94
intensity. See saturation
internal mirror, contaminated 94
interpolated resolution, definition 125
Invert Colors command

shortcuts 111
using 49

isopropyl alcohol, cleaning with 105, 106
items

loading in ADF 76
loading on scanner glass 17
preparing 15

J
jagged images

definition 125
troubleshooting 94

jaggies, definition 118
jams, ADF

clearing 102, 104
preventing 101
to TOC

 122
36
 21
n changes 46
r 115

 to e-mail 30
 and dropping 66
 62
ing
 colors 81
 48

s 79

ooting 95

 122
61
 areas for 42
, cleaning 105, 106
lette, definition 127
les (.fpx)
 122

ges 47

 123
0
nition 123
gging and dropping to 66
OCR 73
e 63
 text
70
ooting 96
lashPix)
 122

t
 123

0
tes 28, 64
asked questions 20
, definition 123
rams 85

fuzzy images
sharpening 48
troubleshooting 92, 94

G
gamma, definition 123
GIF files (.gif)

definition 123
output types for 44
using 63

glass cleaner, using 105, 106
glass, scanner

cleaning 105
definition 129
loading items on 17
preparing documents for 15

grainy, definition 123
graphics

 See also images
cut off 94
file formats 63

Graphics Interchange Format. See GIF files
grayscale

8-bit 117
definition 124
output type, using 44
shortcut for 111

green color channel 59
grinding sounds, troubleshooting 88
Guided Steps

hiding or showing 40
menu shortcut 110
toolbar shortcut 113

gum-backed paper, scanning 15

H
halftone, definition 124
handwriting, converting 73
Height field 45
height, resizing images 45
Help, online

context-sensitive 40, 112, 113
HP Copy Utility 14
printing 13
shortcuts for 112
using 40

hiding Guided Steps 40

highlights
adjusting 51
alarms 53
automatic adjustment 70
clipped areas, checking for 53
definition 124
histogram 56
transparent items, adjusting for 82

histograms 56, 124
Hotmail 30
HP Copy Utility 14
HP Photo Printing Quick Reference Guide 29
HP Precisionscan Pro software

customizing settings 68
features 39
help, using 40
keyboard shortcuts 110
preferences, setting 68
product tour, viewing 13
scanning with 41
starting 40
toolbar shortcuts 113
troubleshooting 89
uninstalling 107
when to use 14

HP Scanjet Button Options 34
HP Scanjet on the Web 112
HP Share-to-Web wizard 28
HTML file formats

definition 124
using 63

hue
adjusting 56
automatic adjustment 70
definition 124
keyboard shortcuts 111

I
image quality, troubleshooting 90
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JPEG files
definition
output ty
using 63

K
keyboard s
keys. See 

L
lamp

broken 1
stays on
time out,
turned o

landscape
languages
large file s

 See also
launching 
lid, scanne
light areas

adjusting
copies, t
scans, tr

light bulbs
broken 1
stay on 

light media
light shield

negative
slides 78

light sourc
lightening 
lines, troub
loading ite

ADF 76
scanner 

loading se
lock

unlockin
long items

M
magazine 

original items
loading in ADF 76
loading on scanner glass 17
preparing 15

Original type, options 36
output dimensions

changing 45
definition 127

output levels, changing 54
output types

automatic selection 70
menu shortcuts 111
optimal resolutions for 46
selecting 43
unavailable for printing images 64

P
pages, multiple

options for 36
scanning 69

Paint files (.pcx) 127
Paintbrush files (.pcx) 127
palette flashing, definition 127
palettes

definition 127
optimized 117
system 131
web 117

paper
loading in ADF 76
sizes, ADF 16
sizes, scanner glass 15
types of 15

paper jams, ADF
clearing 102, 104
preventing 101

Paste command 65
pasting images 65
patterns, descreening 60
PC fax programs, definition 127
PC Paintbrush files (.pcx) 127
.pcx files (Paintbrush) 127
.pdf files

multiple pages, scanning to 36
printing documentation 13
uses for 63

percentages, scaling 45
Photo Printing Quick Reference Guide 29
to TOC

 (.jpg)
 125
pes for 44

hortcuts 110
scanner buttons

00
 87
 extending 69
ff 88
 orientation, definition 126
, OCR 70
ize, option for 36
 file sizes

software 40
r 129

 51
roubleshooting 94
oubleshooting 91

00
87
, scanning 15

s 79

e, XPA 69, 78, 132
images 50
leshooting 91, 94

ms

glass 17
ttings 68

g 87
, scanning 101

pages, scanning 16

making copies
quality, troubleshooting 93
troubleshooting 98
using scanner button 33

manual, printing 13
margins, adjusting for 93
Maximum Pixel Depth

definition 126
option 69

memory, insufficient 94
menu shortcuts 110
menus, troubleshooting 89
messages, error 87
Microsoft Hotmail 30
Microsoft Windows. See Windows
midtones

adjusting 50
automatic adjustment 70
definition 126
range for 50
transparent items, adjusting for 81

Mirror command
shortcuts 111
using 47

mirror, contaminated 94
mirroring images

keyboard shortcuts for 111
using tools 47

models, features 3
Modify, settings 34
moiré, definition 126
More Options button

identifying 25
using 34

moving selection areas 42
multipart forms, scanning 15
multiple feeds, troubleshooting 101
multiple pages

options for 36
scanning 69

N
negative holder

definition 126
using 79

negative light shield
definition 126
using 79

negatives
adjusting colors 81
scanning 79
troubleshooting 95
XPA (Negatives) 48

new documents opening, troubleshooting 98
New Scan command

shortcuts 110, 113
using 41

news clippings, scanning 15
noise reduction

definition 126
settings for 69

noisy scans, troubleshooting 88
normal file size, option for 36
not responding, troubleshooting 88
NTSC Gray channel 59
Number of copies button 25

O
OCR

accuracy of 73
definition 126
languages for 70
options for 70
output types for 44
preparing text for 73
troubleshooting 96

onionskin paper 16
online Help. See Help, online
opening software 40
Optical Character Recognition. See OCR
optical resolution, definition 127
optimized palette, definition 117
optimized settings 23
optional automatic document feeder. See ADF
optional transparency adapter. See XPA
options

Controls tab 71
E-mail button 35
preferences, setting 68
Resolution 70
Scan To button 37
scanner button settings 34
Scanner tab 69
Selection Area tab 70
text 70

Options button 62
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Photo Rep
identifyin
using 29

photos
inverting
output ty
quality o
troublesh

pink image
pixel color

transpar
viewing 

pixel depth
pixel, defin
pixels per 
platforms, 
PNG files (
pointers. S
portable ne
portrait orie
positioning

definition
negative
slides 77

posting sca
Power Sav
power, rec
PPI (pixels
Precisions

Prec
Preference

for scann
for scann
menu co

preparing o
preview wi
previewing

options f
toolbar s
using HP

Print comm
shortcuts
using 64

Print Setup

S
saturation

adjusting 57
automatic adjustment 70
definition 129
keyboard shortcuts 111

Save As command, shortcuts 110, 113
saving custom settings 68
saving to files

formats 63
toolbar shortcuts 113
using HP Precisionscan Pro software 62

scalable images, file formats 63
Scale field 45
scale, definition 129
scaling images 45
Scan in color option 36
Scan menu, shortcuts for 110
Scan To button

identifying 24
options 37
using 26, 27

Scan to CD
shortcuts 110, 113
using 66

Scan To command
shortcuts 110, 113
using 61, 64

Scan using channel 59
Scanjet Button Options 34
Scanjet on the Web 112
scanner bed

definition 129
printing entire 64
selecting entire 42

scanner buttons
identifying 24
models including 3
settings 34
troubleshooting 89
when to use 14, 23

scanner glass
cleaning 105
definition 129
loading items 17
preparing documents for 15
Scanner Glass command 48
to TOC

rint button
g 24

 colors 49
pes for 44
ptions 36
ooting 92
s, troubleshooting 95

ent items 83
55
, options for 69
ition 127
inch (PPI), definition 128
file types for 63
.png) 63
ee cursors
twork graphics (.png) 63
ntation, definition 128

 plate, XPA
 128
s 79

ns, definition 128
e button 25
onnecting 85
 per inch), definition 128
can Pro software. See HP 
isionscan Pro software
s
er buttons 34
ing software 68

mmand 110
riginals 15

ndow, definition 128
 scans
or 69
hortcut 113
 Precisionscan Pro software 41
and
 110, 113

 110

printing
copies 33
documentation 13
from HP Copy Utility 14
resolutions for 128
scans 64
toolbar shortcuts for 113
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definition 129
using 63

right-click, definition 129
Rotate Left command

shortcuts 111, 113
using 47

Rotate Right command
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using 63
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file formats 63
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XPA (Negatives) command
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